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Explosives have become increasingly common on the battlefield worldwide.
Military personnel and civilians often experience blast loading to the lower extremity due
to its direct contact with the ground and floor of vehicles. The pressure and axial loading
from these incidents often lead to detrimental injuries. These injuries can be due to a
number of mechanisms terming them primary, secondary, tertiary, or quaternary blast
injuries. Of these injuries, this study will focus on primary and tertiary injuries,
specifically bone fractures, compartment syndrome, and soft tissue disruption which
often result from blast loading due to these mechanisms. However, the pressure and load
levels causing these injuries are unknown. Currently, the methodologies, which study the
injury criteria and design of blast mitigating structures, are limited. The main limitations
are the lower rates of testing (automobile), specimen limitation (cadavers, surrogates,
etc.), cost, and testing repeatability. Consequently, the goal of this dissertation is to
develop a realistic computational model which can be used to improve the injury criteria,
personal protective equipment (PPE), and vehicular structure in a cost effective and
timely manner. Three Aims were thus pursued. For Specific Aim 1, a standing lower

extremity was developed, verified, and simulated with several open-air blast loading
conditions. Specific Aim 2 focused on validating the lower extremity model using
experimental drop tower test results. In the drop tower simulation, the lower extremity
model was successfully converted into a seated posture model and setup with similar
loading and boundary conditions as the experiment. Specific Aim 3 involved
incorporating a boot into the standing lower extremity model and evaluating its ability to
mitigate pressure waves. In summary, Specific Aims 1 and 2 developed, verified, and
validated a realistic human lower extremity model for the use in blast simulations.
Specific Aim 3 further confirmed the models use in developing PPE.
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CHAPTER I
INTRODUCTION

The use of explosives and fragmentation devices dates back to World War I. It is
said that over 360 different types of mines have been used worldwide. Prior to increased
personal protective equipment (PPE), these weapons accounted for over 70 percent of all
deaths and injuries on the battlefield. As a result of the advancement in PPE, the number
of surviving casualties with extremity injuries has increased tremendously. Of these
injuries, at least 54 percent are lower extremity injuries. The lower extremity is
commonly injured due to it being in direct contact with the ground and floor of vehicles.
When a person is wounded in an explosion, multiple injuries are likely to occur.
Many different types of injuries can occur in the lower extremity, including amputations,
fractures, crush injuries, compartment syndrome, burns, and soft tissue deformation. Of
these injuries, amputations, fractures, skin deformation, and compartment syndrome will
be the main focus of this study. A single explosion can cause multiple casualties placing
a significant burden on field doctors and hospital facilities (Ramasamy et al. 2011).
Incorporating energy absorbing materials into PPE and vehicles allows for more
protection against blast waves. In order to improve PPE and vehicle structures, a more
precise injury criterion for the lower extremity needs to be created. Finite element
analysis (FEA) is becoming a prominent part of this research due to the many
1

experimental difficulties associated with blast related research; however, the reliability of
FEA depends on the detail of the anatomy, material behavior, and injury mechanisms.
The main goal of this dissertation was to develop a computational model which
can help in the investigation of open air blast injuries in the lower extremity, the effects
of anti-vehicle explosives on the lower extremity, and the protection of current protective
footwear. The open air blast investigation involved the development of the first highly
detailed and realistic lower extremity model for FEA. Pressure, stress, and strain values
were examined in the skin, muscle, and bone tissues of the lower extremity at different
blast source locations, focusing primarily on land mine cases. The same lower extremity
model was later altered to a seated position and used to simulate experimental drop tower
testing as a source of model validation. Last, standard military footwear was
incorporated into the open air model to assess its ability to mitigate blast waves. The
specific aims and hypotheses for this dissertation work are listed as follows:


Specific Aim 1: Develop a lower extremity model for analyzing open air blast
effects due to explosives and integrate it with numerical finite element analysis
tools.
Hypothesis: With the development of a highly detailed realistic FE model
of the lower extremity, a more detailed and precise injury criterion can be
developed for open air injuries.
Approach: Construct a 3D model of a standing human lower extremity
from CT, MRI, and cryosection images and implement it into
Abaqus/Explicit at blast conditions.

2



Specific Aim 2: With experimental testing, validate a lower extremity model for
analyzing blast effects due to anti-vehicle warfare.
Hypothesis: Axial loading on the lower extremity will cause injuries
which are highly dependent on peak load and duration, foot position
relative to the floor of the vehicle, and personnel age.
Approach: Obtain experimental data from drop tower testing and perform
FE simulations with the same boundary conditions and a seated lower
extremity model.



Specific Aim 3: Analyze the ability of current military footwear to dissipate blast
waves and mitigate injuries.
Hypothesis: The effectiveness of military footwear can be more
accurately and efficiently tested with FE simulations.
Approach: Create a 3D model of a military boot and incorporate it into
the landmine case.

3

CHAPTER II
BACKGROUND

2.1

Anatomy of the Human Lower Extremity
In order to understand the injuries which occur on the lower extremity, it is

extremely important to study the structure and function of the components which
comprise it. Each part of the leg supports the function of another part, making the lower
extremity critically dependent on the function of all components. The orientation of the
lower extremity is also important to consider when an impact occurs. The lower
extremity is commonly divided into the following regions: thigh, knee, lower leg, and
ankle/foot. A summary of the bones and muscles can be seen in Figure 2.1.

4

Figure 2.1

Summary of bones and muscles in the human lower extremity.

(Courtesy: (Dawson 2004), http://www.britannica.com/EBchecked/topic/334805/leg,
and http://cnx.org/content/m44781/latest/#fig-ch38_01_13)
The thigh region consists of the area between the pelvic bone and the knee. The
largest bone in the body, the femur, is located in this region. It acts to transmit the body
weight from the pelvis to the tibia. The muscles of the thigh region can be divided into
three compartments: anterior, medial, and posterior (Huelke 1986). The anterior
compartment is composed of the hip flexors and knee extensors. The medial
compartment consists of adductor muscles. The posterior compartment features the
hamstrings which are for flexing the knee and extending the hip and thigh.
The knee region is the joint that connects the femur and lower leg regions. It is
composed of the patella, tendons, muscles, and ligaments. The knee joint is a hinge type
joint that controls flexion and extension in the leg. The patella, or kneecap, is often
vulnerable due to its common direct impacts.
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The lower leg is composed of two bones, the tibia and fibula. The tibia is located
in the medial portion of the leg while the fibula is in the lateral portion. The tibia is the
longer and larger bone in comparison to the fibula, making it primarily responsible for
weight bearing in the lower leg region. The muscles in the lower leg can also be grouped
into three compartments (anterior, lateral, and posterior) (Huelke 1986). The anterior
compartment muscles are responsible for ankle extension. The lateral compartment
muscles assist in the evertion of the ankle. The posterior compartment muscles flex the
ankle and phalanges.
The ankle is a synovial join which links the tibia and fibula to the foot. The foot
can be divided into three main parts: the hind foot, mid foot, and forefoot. Each part
works together to support body weight and facilitate motion.
2.2

Basic Physics of Blasts
An explosion occurs when there is a sudden release of energy. The source of an

explosion can be deliberate or accidental. Deliberate explosions may result from
demolition charges, weapon systems, or improvised explosive devices (IEDs). An
accidental explosive can include ignition of gas clouds, flammable liquids, or chemicals.
This release of energy is flowed by a blast wave, propulsion of surrounding material, and
sometimes thermal radiation (Cullis 2001).
The blast wave consists of an immediate rise in pressure that dissipates over time
and distance. After the positive phase of the blast dissipates, a negative pressure phase
develops and forms a vacuum. The maximum pressure that occurs is called the peak
pressure or overpressure. This typical pressure history is commonly referred to as a
Fried-lander wave (Born 2005) and can be seen in Figure 2.2. The strength of an
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explosive is characterized by its weight or size, standoff distance, positive pulse duration,
and medium in which it occurs (Cullis 2001, Born 2005, Ngo et al. 2007, Usmani et al.
2010).

Figure 2.2

Typical pressure history or Fried-Lander wave

(Ramasamy et al. 2011).
2.3
2.3.1

Devices
Antipersonnel Landmines
Antipersonnel landmines are a form of weaponry which is placed on or under the

ground. It is detonated by direct pressure (being stepped on) or electromagnetic waves.
Landmines are a risk for both civilians and military personnel and are a problem
worldwide. In Afghanistan alone, it is reported that there are over 10 million landmines
of more than 50 types present.
There are three main types of antipersonnel landmines: blast or static, bounding
fragmentation, and directional fragmentation. Blast or static mines are buried just below
7

the surface and are detonated by pressure. An example of a blast (static) mine can be
seen in Figure 2.3. Bounding fragmentation mines are buried just below the surface and
are detonated by a fuse or tripwire. Directional fragmentation mines are laid on the
surface and are detonated by an electrical charge, time fuse, or tripwire. This study will
focus on blast or static mines only, due to the difficulty in modeling fragmentation
landmines.

Figure 2.3

Example of antipersonnel blast (static) mine.

Courtesy: United Nations Mine Action Service (Brevard et al. 2012).
Blast landmines are small mines designed to activate when a person steps on
them. These devices are often designed to injure but not kill an individual (Cronin 2003,
Davies 2004). From a merciless military point of view, injuring a soldier rather than
killing has its advantages. If a soldier is killed by a mine, the rest of the unit will bury
him and continue on their mission. On the other hand, if a soldier is injured, at least two
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members of the unit will carry the soldier back to base, leaving the unit more vulnerable
to attack.
2.3.2

Improvised Explosive Devices
IEDs are devices that are placed or fabricated in an improvised manner and

incorporate a number of chemicals (Figure 2.4). They are designed to destroy,
incapacitate, or distract military personnel. They are usually designed using non-military
components and can vary in size, shape, form, and explosive power. IEDs are easy to
make, use, house, and hide.

Figure 2.4

Example of IEDs displaying the improvised incorporation manner.

Courtesy: United Nations Mine Action Service (Brevard et al. 2012).
The casings can range in size from a cigarette pack to a large vehicle. They are
used to hide the IED or provide fragmentation. Propane tanks, fuel cans, and battery acid
have been added to IEDs to increase the blast. The triggers for these devices can be
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command detonated (ex: cell phone, car alarm, etc.). This allows the bomber to escape
prior to detonation, and it allows them to target specific locations at a certain time. IEDs
can be person-borne or vehicle-borne and can vary immensely in size.
2.3.3

Anti-vehicular Devices
Anti-vehicular mines are designed to damage armored or other vehicles and their

occupants. Anti-vehicular warfare can be traced back to 120 BC. In the twentieth
century, motorized transport became a common use for armies. With this, anti-vehicle
(AV) landmines became prevalent. These mines are triggered when a vehicle drives over
them. An example of device, its detonation, and the damage to a tank can be seen in
Figure 2.5. The detonation produces a pressure wave which can vary immensely
depending on the charge mass. There are several hundred types of anti-vehicular mines
in the world and millions are left behind post-war (Brevard et al. 2012).
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Figure 2.5

Example of (A) Anti-vehicular device, (B) explosion, and (C) damage to
tank.

Courtesy: Wikimedia Commons (Brevard et al. 2012) and http://defenseupdate.com/products/c/cougar.htm.
2.4

Injury Mechanisms
As a result of blasts, lower extremity injuries can be categorized as primary,

secondary, tertiary, or quaternary injuries depending on the type of forces sustained.
These injuries can be evident in a person as one or a combination of these injury types.
Table 2.1 summarizes the mechanisms leading to the injuries with respect to the lower
extremity.
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Table 2.1
Type
Primary

Summary of blast injury mechanisms.
Characteristics
Blast wave mediated, overpressure

Secondary
Tertiary
Quaternary

Types of Injuries
Amputation, fractures, tissue
disruption
Results from flying debris and fragments Multi-fragmentary fractures, soft
tissue injuries
Displacement of casualty or objects near Fractures due to axial loading and 3
casualty
point-bending
All explosion-related injuries not due to Burns, psychological trauma,
primary, secondary, or tertiary
chemical exposure
mechanisms

Primary blast injuries result from impact of the blast wave and overpressure with
body. As the blast wave or pressure wave travels through tissues of different densities,
the speed of the wave changes, causing stress and shearing to occur. The tissues are
damaged at the micro and macroscopic levels through spalling, implosion, and shear.
Spalling is a result of movement from one medium to a less dense medium and is defined
as displacement. Implosion is just the opposite, occurring when the pressure wave travels
from one medium to a more dense medium. Last shearing or inertia is stress created by
the pressure wave traveling through different tissues at different velocities and occurs at
tissue interfaces. Due to these injuries occurring when a person is in close proximity to
an explosion, they are associated with high mortality rates. Examples of a common
primary blast injury in the lower extremity and a common medical procedure to relieve
one of these injuries in the lower extremity can be seen in Figure 2.6.
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Figure 2.6

Examples of primary blast injuries in the lower extremity.

Notes: (A) Femur fracture due to blast wave (Ramasamy et al. 2011) and (B) fasciotomy
performed after blast injury which caused compartment syndrome in lower leg (Wolf et
al. 2009).
Secondary effects are caused by bomb fragments and debris that are physically
displaced by the blast. The fragments have high velocities initially but decrease during
travel. Thus, the injury radius is higher than primary blast injuries but less than
projectiles from firearms. In relation to the lower extremity, these injuries include
penetrating wounds and extremity fractures due to direct impact of fragments (Figure
2.7).
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Figure 2.7

Example of secondary injuries (ankle/foot fractures and soft tissue damage)
in the lower extremity

(Guermazi et al. 2013).
Notes: White arrowheads indicate point of entry, black arrowheads indicate metallic
foreign bodies, and opaque spots also indicate foreign bodies.
Tertiary blast injuries are created when an individual is physically thrown or
moved by the blast wave and sustain blunt trauma injury. An example of such injury
occurs when armored vehicles are struck by AV mines. The footplate is accelerated
rapidly by the blast which can cause injuries to personnel in direct contact with the plate
(Figure 2.8).
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Figure 2.8

A tertiary blast injury which occurred after an AV mine causing calcaneus
(heel) fractures due to axial loading

(Ramasamy et al. 2011).
If an injury cannot be placed in any of the previous categories, they are termed
quaternary or miscellaneous injuries. These usually include burns, psychological trauma,
and chemical exposure.
This study will focus mainly on primary and tertiary injuries since the focus will
be on open air (on field) and enclosed (army tank) situations. A summary of skeletal
injuries due to open and enclosed situations can be seen in Figure 2.9. It shows that in
both cases the lower extremity accounts for the majority of the injuries, with the
tibia/fibula and feet injures most prevalent.
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Figure 2.9

Anatomical pattern of skeletal injury from explosion

(Ramasamy et al. 2011).
2.5

Current Injury Criteria
Of the accessible data on lower extremity injury criteria, most of it focuses on

automotive data (Nilakantan et al. 2009). The criteria found have been established
through testing on live human subjects, cadavers, and surrogates. Disadvantages come
along with each of these types of tests. Live human and cadaver testing can be very
limited and costly. For surrogates it is difficult to construct a device that will accurately
represent the material properties and mechanical properties of human tissue, and
commonly the materials used are expensive. Due to these issues, reproducibility and
testing of multiple samples is difficult to obtain.
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Most of the data found is based on the Abbreviated Injury Scale (AIS)
(Nilakantan et al. 2009, Usmani et al. 2010), which is a system rating severity of injury
from 0 to 6, with 6 being fatal. The majority of research focuses on tibia and fibula
maximum compressive axial forces and foot/ankle injury for axial loading. The
maximum forces vary from source to source and are not necessarily a good means of
comparison for all blast loading conditions due to the multidirectional forces being
applied.
2.6
2.6.1

Previous Injury Evaluation Methods
Open Air Blast
Anti-personnel (AP) mines and improvised explosive devices (IEDs), also known

as land mines, have become extremely prevalent in Iraq and Afghanistan due to their
relative low cost, maintenance, and simplicity to deploy. These land mines are often
activated when a person steps on the mine. When a victim is directly subjected to the
blast, this is referred to as an open air blast. These devices usually contain little metal
and are well concealed in the ground causing military personnel to step on these devices
or be near someone who does. The injuries therefore commonly occur in the lower
extremity by the direct effect of the blast on the tissues.
Currently, there have not been many studies focusing on the primary, or direct,
effects of blast waves on the lower extremity. The most relevant study was performed by
Hull et al where a goat hind limb model was used to investigate the pattern and
mechanism of traumatic amputation by blasts (Hull et al. 1996). Goat hind limb bones
were encased in gelatin and subjected to three different explosive charges. In addition, a
very simplistic model of a bone was subjected to a 4 kg explosive (Figure 2.10). The
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responses were observed both experimentally and computationally. Hull et al. found that
the blast wave itself can be capable of soft tissue and bone damage. These results support
the hypothesis that amputation occurs preferentially through the shaft of the bone rather
than at the joints. While this study was a good investigation of the direct effects of blast
waves on the lower extremity, a more detailed model would provide more specific and
accurate injury data.

Figure 2.10

2.6.2

Hull et al’s simplistic computational model of bone.

Underbelly Blast
Occupants of infantry vehicles are extremely vulnerable to IEDs and anti

vehicular (AV) mines (Nilakantan et al. 2009). This type of event is commonly referred
to as an underbelly blast. Due to the increase in use of these devices, research has turned
to the development of energy absorbing structures in the vehicles in order to reduce the
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loads transmitted to the occupant through the floor and seat of the vehicles. These energy
absorbing structures include deformable seats, armoire plating, and crushable tubular and
honeycomb structures (Nilakantan et al. 2009).
The occupant’s lower extremity interacts with the vehicle’s floor, foot pedals, and
footrest. Currently, the shock waves which transmit through the floor to the lower
extremity are extremely high and not absorbed sufficiently enough to avoid injuries.
Some researchers have begun studying this situation, but the current lower extremity
models and testing methods can be improved upon.
Postmortem human subjects (PMHS) have been used to study the effects of AT
mines on the lower extremity. One study applied axial loading to a foot-ankle complex,
by mounting a lower extremity to a sled frame and applying an impact load through a
pendulum (Yoganandan et al. 2011). The setup can be seen in Figure 2.11. One issue
with this type of model is the prediction of fractures. The age and bone quality of the
specimen highly effects whether or not a fracture occurs. Another limitation is the
absence of active muscle response. The amount muscle contraction affects short-time
interval loads is unknown, and some believe it may not considerably alter the load path or
response (Stemper et al. 2003).
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Figure 2.11

Stemper et al’s pendulum loading of the PMHS foot-ankle complex.

Nilakantan et al performed a numerical simulation of a HYBRID III dummy in
LS-DYNA (Nilakantan et al. 2009). The dummy was seated and subjected to a series of
vehicle floor vertical velocity pulses. The position of the feet was varied from full
contact to heel contact. The simulation was validated with experimental testing. The
study found that the dummy was able to provide an accurate response to landmine
detonations under vehicles; however, their model is not able to capture specific injury
mechanisms. They state that more advanced and biofidelic models are needed.
2.6.3

Military Personal Protective Equipment
AP landmines pose a serious threat to military and civilians which has led to the

importance of evaluation and improvement of PPE in many countries. Standard military
boots provide minimal protection under blast loading and fail easily. Several new
designs have been made to specifically counteract AP mines. These boots contain wedge
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designs, honeycomb energy absorbing structures, and structures increasing standoff
distance from the ground.
There are a variety of approaches used to test PPE, but the three must common
surrogates used to represent the leg are mechanical, frangible (synthetic), and cadaver
(Cronin et al. 2003). Each of these testing approaches involves explosive testing.
Depending on the level of detail and information needed when testing the PPE, the test
method may be different. The optimal test methodology addresses the following issues:
consistency and repeatability, transferability (can be implemented and used in multiple
countries), ability to rank protection based on injury outcome, and correlation to expected
level of trauma (NATO).
Mechanical surrogate legs’ main advantage is re-usability. These surrogates
represent the dimensions and mass of a human leg; however, the material is usually made
of steel. These qualities make a mechanical leg a good measurement of momentum
transfer to the leg but not a good injury predicting model.
Frangible surrogate legs are models which try to mimic the human geometry and
material properties (Figure 2.12). This allows for representation of bone fractures and
tissue disruption. Although frangible surrogate legs mimic the human leg more than
mechanical surrogates, they are more expensive. Since the legs account for damage, each
test requires new materials making the procedure costly.
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Figure 2.12

Example of a frangible surrogate leg.

Courtesy: Defense Science and Technology Organization, Australia.
Both whole cadavers and isolated lower extremities have been used for testing
PPE. Being able to perform realistic autopsies and provide representative geometry are
the obvious benefits of using cadaver models. The main issues with using cadaver
subjects are the age of the donor and pre-existing diseases. These concerns can affect the
mechanical properties of the tissues and ultimately alter testing results.
In addition to surrogate testing, FEA has become an increasing research area in
PPE development due to its ability to provide a reproducible testing means with low cost.
For numerical procedures to help with the advancement of PPE, more complex lower
extremity models and material models will need to be developed. Keong developed a FE
foot model with boot, and performed blast simulation in Abaqus finding boot failure
(Keong 2011). The study suggested future work due to issues with the mesh and elastic
material properties representing biological tissues.
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CHAPTER III
OPEN AIR BLAST FINITE ELEMENT SIMULATION OF LOWER EXTREMITY

3.1

Introduction
Explosions are the leading cause of death on the battlefield (Champion et al.

2009). When detonated, explosives form an outward propagating blast wave that
produces large and abrupt accelerations and deformations. The resulting loads pose
serious threats to military personnel and civilians.
Due to the human lower extremity being in direct contact with the ground, its
components are commonly injured during explosions and represent at least 54% of
combat wounds (Owens et al. 2007, Dougherty et al. 2009). Lower extremity injuries can
be categorized as primary, secondary, or tertiary injuries depending on the type of forces
sustained. Two major extremity injuries that need further research are traumatic
amputations and compartment syndromes. Partial or complete amputations are caused by
high overpressures causing bone fractures and soft tissue ruptures. Fractures, tissue
damage, and burns can elevate compartmental pressures causing limb and life threatening
conditions, thus making measurement of compartment pressure extremely important.
Previously, amputations and compartment syndrome have been linked to other factors in
addition to blast overpressure, but now blast overpressure is being considered a direct
cause in some situations. The exact blast overpressure to cause these injuries is not
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known, making the need for these values critical (Hull et al. 1996, Born 2005, Ritenour et
al. 2008, Wolf et al. 2009).
Of the accessible data on lower extremity injury criteria, most of it is focused on
automobile crashes (Nilakantan et al. 2009), and the criteria used was established through
testing on live human subjects, cadavers, and surrogates. There are disadvantages with
each of these subject types. Although experimental studies have been performed to
advance the understanding of blast injuries on lower extremities, limited progress has
been made in the computational area (Nilakantan et al. 2009, Ramasamy et al. 2009).
The development of a robust and complex Finite Element (FE) lower extremity blast
model is still warranted. By accurately developing this model, simulations will allow for
cost effective, efficient, and effective ways of understanding the true behavior of lower
extremity injuries.
This chapter focuses on developing a standard blast wave simulation procedure
and establishing upper and lower bounds for obtaining realistic data. Our goal was to
evaluate primary blast damage effects incurred on the lower extremity after an explosion
using Abaqus/Explicit software [Dassault Systèmes SIMULIA]. A standing position
lower extremity has been modeled with a detailed mesh created for analysis at different
blast conditions. Multiple cases were simulated in order to identify if specific pressure
trends can be correlated with injuries due to direct contact with a landmine. Our results
showed that we were able to complete the first step towards developing a realistic FE
lower extremity model which will allow for enhancing the design of protective equipment
and improving injury metrics.
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3.2
3.2.1

Methods
3D Reconstruction of Standing Lower Extremity
Using 1134 images, the geometry of the lower extremity was developed from

axial computed tomography (CT) scans and cryosections contained from the National
Library of Medicine’s Visible Human Male (National Institute of Health, MD). The skin
and muscles were constructed from the cryosections, while the bones were more
accurately obtained from the CT images. Using Mimics software (Materialise, NV) each
component was manually and semi-automatically segmented into a total of 18 different
parts. The bones were separated into the following groups: hip, femur, patella, tibia,
fibula, talus, calcaneus, and tarsals/metatarsals/phalanges. Nine different groups of
muscles were selected according to function and location. The muscle groups can be
summarized as follows: gluteus maximus, gluteus medius, gluteus minimus, anterior
thigh, biceps femoris, calf, Sartorius/gracilis/semitendonous, tibialis/proneus/extensor,
and foot muscles.
3.2.2

Mesh Development
Once each part was segmented into a mask, they were uploaded into ScanIP,

image processing software (Simpleware, UK). Several meshes of the lower extremity
were created by down-sampling the image pixels two, three, and four times. The meshes
contained hybrid volume elements with hexahedral elements within each part and
tetrahedral elements on the surface. This method provides a smooth and conforming
interface between parts and coincident nodes and elements across boundaries. In order to
run a blast simulation in Abaqus/Explicit, the lower extremity mesh was enclosed in an
“air” mesh. To shorten simulation run-times, meshes included only the knee to the foot.
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3.2.3

Blast Simulations
Using Abaqus/Explicit, blast simulations were performed using an incident wave

procedure. Due to the lack of accurate experimental data available on actual wartime
blast pressure profiles, the FE model was subjected to an initial blast wave, based on
experimental and computational work done by Chafi et al. that contained a high and low
intensity blast (Chafi et al. 2009, Chafi et al. 2010) (Figure 3.1A). Using properties from
published literature (Horgan et al. 2003, Sligtenhorst et al. 2005, Moore et al. 2009), the
skin, bone, and muscle were treated as elastic materials. For skin, values in density,
modulus, and Poisson’s ratio were set to ρ= 1040 kg/m³, E=16.7 MPa, and ν=0.42,
respectively. For bone, values in density, modulus, and Poisson’s ratio were set to ρ=
2000 kg/m³, E=15,000 MPa, and ν =0.23, respectively. For muscle, values in density,
modulus, and Poisson’s ratio were set to ρ= 1100 kg/m³, E=110 MPa, and ν =0.49,
respectively. Many human body blast load-related studies have assumed materials to be
linear elastic for their FE calculations (Horgan et al. 2003, Moore et al. 2009, Chafi et al.
2010).
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Figure 3.1

Basic setups used for blast simulations.

Note: (A) Air pressure profiles for blast scenarios
(B) Three different blast location cases and the data analysis points. Case 1:
Source located near outer ankle region. Case 2: Source located under foot
(landmine case). Case 3: Source located near inner region of ankle.
Three cases were simulated with the locations chosen as shown in Figure 3.1B,
where Cases 1 and 3 represent side impacts while Case 2 represents the common direct
contact with a landmine. The high intensity pressure profile was simulated for each case.
The following source point distances for Cases 1, 2, and 3 were 60 mm, 70 mm, and 175
mm, respectively. Data points were chosen along the line of blast wave propagation for
each case (Figure 3.1B) to evaluate the pressure, impulse, von Mises stress, and
maximum principal strain. Initially, a mesh refinement study was performed on three
different meshes to obtain a mesh that adequately provided a converged solution with
computational efficiency. The low intensity pressure profile, and Case 1 were used to
study the convergence of the solutions due to the decreased computational time required.
To assess the feasible bounds of the stress state, FE simulations were executed by
varying surface contact definitions of the lower extremity components as either
completely fixed or frictionless. These definitions were applied to the following
interactions: skin to bone and muscle to bone. By varying the surface contact definitions,
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lower and upper bounds for the true stress-strain responses of the lower extremity were
can be obtained. The low intensity pressure profile, and Case 1 conditions were used to
identify the bounding values.
3.2.4

Land Mine Case
Due to the land mine case being the most drastic injury case, more simulations

were executed in order to examine the effects of blast intensity, blast duration, and blast
position relative to the foot on the results. First, the location of the detonation relative to
the bottom of the foot can have an effect on the results. This was investigated by
simulating a heel detonation, toe detonation, and mid foot detonation (Figure 3.2) using
the high pressure profile.

Figure 3.2

Land mine source point location simulations.

Note: (1) Heel detonation, (2) mid foot detonation, and (3) toe detonation.
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Next, different pressure profiles were investigated due to the variation in the peak
pressure and pressure duration of blast waves found in literature. A high intensity, short
duration (HS) pressure wave was applied at the same source point as Case 2 (Fichera et
al. 2013). A mid intensity, long duration (ML) pressure wave was applied at the same
source point as Case 2. The two pressure profiles can be seen in Figure 3.3, along with
the high pressure case from Section 3.2.3, which will represent a low intensity, mid
duration (LM) pressure profile in this section.

Figure 3.3

Pressure profiles varying in peak pressure and duration.

Notes: HS = High intensity, short duration, ML = Mid intensity, long duration, and LM
= Low intensity, mid duration
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3.3

Results
We focused on the first 3 ms of the FE simulations to provide an understanding of

the shock wave-related tissue damage. A realistic model of the lower extremity with 18
different parts was successfully developed (Figure 3.4A). The main components were the
skin, bones, and muscles. Each mesh was ranging from 0.9 to 4.2 million elements and
displayed exact contact matching between components (Figure 3.4B-C). A summary of
the types of elements and relative CPU time required to run the simulation can be seen in
Table 3.1. The mesh refinement study showed little difference between each mesh’s
pressure propagation, confirming solution convergence (Figure 3.4D). Hence, the mesh
containing approximately 1.6 million elements, with higher anatomical accuracy than the
0.9 million elements mesh with moderate computational cost, was chosen and used in the
subsequent simulations and analyses.
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Figure 3.4

Development of the lower extremity mesh.

Note: (A) 3D masks of the skin, muscles, and bones modeled in Simpleware, (B) the 3x
lower extremity and air mesh, (C) High quality mesh displaying the mesh’s exact contact
matching between components (Tan=Skin, Red=Muscle, Blue=Bone), and (D) Pressure
plots at each point in Case 1 for each mesh used in the refinement study (2x=4.2 million
elements, 3x=1.6 million elements, 4x= 0.9 million elements).
Table 3.1

Summary of the three meshes used in the mesh refinement study.

Mesh

Nodes

Hexahedral Tetrahedral Total
Elements
Elements
Elements

Relative
CPU Time

2x

1665647

888007

3348158

4236165

273.57

3x

595432

287017

1332187

1619204

103.29

4x

348589

167485

773112

940597

58.29

The pressure, impulse, von Mises stress, and maximum principal strain were
evaluated along the line of pressure propagation in Case 1 in order to evaluate the effects
of different surface contact definitions (fixed versus frictionless). The pressure, von
Mises stress, and maximum principal strain levels shown in Figure 3.5 all reveal that
varying the contact definitions between each material made no significant difference on
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the results. This is supported by Chafi et al’s (Chafi et al. 2010) human head simulation
findings. Therefore, in our studies the surface-to-surface interaction properties will be
assigned as tied contact properties, which provide a more realistic transfer of loading at
the interface than frictionless properties.

Figure 3.5

Case 1 results from the upper and lower bounds study investigating the
effects of fixed versus frictionless contact definitions.

Note: (A) Pressure, (B) von Mises stress, and (C) maximum principal strain plots along
the line of blast propagation (refer to Figure 3.1)
3.3.1

Pressure Wave Propagation
The FE simulation results provide evidence of pressure wave propagation through

the lower extremity (Figure 3.6) as the arrival of pressure at each location was consistent,
thus confirming accurate pressure propagation. Cases 1 and 3 showed inversely
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symmetrical pressure patterns of each other as the leg was impacted from almost exact
opposing directions. When comparing all cases, Case 2, the landmine case, experienced
the most discernible differences in pressure propagation with stress states being an order
of magnitude higher. With little skin or muscle located at the point of impact, the bone
carried most of the pressure. In Cases 1 and 3, the skin seemingly dampens the pressure.
A very important observation is the difference in response between each material. When
propagating through the bone, the shock wave alternates between compressive and tensile
states. The response of muscle and skin, however, tend to realize a longer duration tensile
state.

Figure 3.6

Pressure plots from each case along their line of blast propagation.

Note: Skin=Blue lines, Muscle=Red lines, Bone=Tan lines
3.3.2

Impulse
Figure 3.7 presents the impulse values along the line of pressure propagation for

each case. Damping is observed as the shock wave travels through the lower extremity in
Cases 1 and 3; however, a build-up of pressure in the bone is observed in Case 2. The
impulse values drop substantially after the shock wave passes through the leg, indicating
the role of skin in damping the shock wave. Due to the highly rigid structure of bone and
the decreased surface area of skin at the point of impact in Case 2, a rapid-flexure is
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observed to cause a buildup of impulse in the bone. This phenomenon can also be
correlated with the rapid fluctuations from the pressure oscillations.

Figure 3.7

Impulse plots from each case along their line of blast propagation.

Note: Skin=Blue lines, Muscle=Red lines, Bone=Tan lines
3.3.3

Von Mises (Shear) Stress and Maximum Principal Strain
The von Mises stress was calculated over time at the same locations along the line

of pressure propagation in each case (Figure 3.8). In comparison to the pressure plots,
the von Mises stresses are close to an order of magnitude higher, meaning the shearing
forces are much greater than the normal forces. Such higher levels of shearing forces
cause the bones in the LE to have large shear strains, which could compound to the
failure of fibula and tibia along its shaft. The oscillatory pattern here is less pronounced
than the pressure. The most fluctuation is again observed in the bone locations.

Figure 3.8

Von Mises stress plots from each case along their line of blast propagation.

Note: Skin=Blue lines, Muscle=Red lines, Bone=Tan lines
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Figure 3.9 presents the plots of maximum principal strain in each case varying
with time. Similar to the pressure and the von Mises stress profiles, the maximum
principal strain profile showed oscillatory patterns with non-uniformity between
materials. Oscillations were most dominant in the skin. This pattern of expansion and
contraction is also observed in the muscle.

Figure 3.9

Maximum principal strain plots from each case along their line of blast
propagation.

Note: Skin=Blue lines, Muscle=Red lines, Bone=Tan lines
To assess if any failure occurred, Table 3.2 displays a summary of maximum
principal stresses for each material in each case compared to Ultimate Tensile Strengths
(UTS) of each material from literature (Yamada et al. 1970). Muscle is the only material
found to surpass failure, occurring in all three cases.
Table 3.2

Summary of the ultimate tensile strengths of each material from literature
and the maximum principal stresses found in each material for each case.

Material Ultimate Tensile
Strength (MPa)

Maximum Principal Stress (MPa)
Case 1

Case 2

Case 3

Skin

15.2

0.760

1.005

1.165

Muscle

0.157

5.785

7.225

9.650

Bone

143.0

17.85

28.75

24.63
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3.3.4

Analyses of Primary Blast Injuries
To better understand primary blast effects on bone, pressure contours and average

pressure along the tibia and fibula were analyzed (Figure 3.10). Figure 3.10 confirms
pressure damping along the bone in all three cases. The complexity of pressure
propagation in each bone depends on how the blast impacted the bone and the size of the
bone. We can see that the fibula has a more complex reaction due to its smaller size
causing less damping to occur. Cases 1 and 3 are also more complex due to the wave
impacting the side of the bone. Case 2 has the highest pressure occurrence in bone. In
addition, we found that maximum pressures occur in the foot bones and shaft of the tibia
and fibula (Figure 3.11).
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Figure 3.10

Pressure propagation in the tibia and fibula averaged at three transverse
cuts.
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Figure 3.11

Pressure (MPa) in the bones for each case at 1.35 ms.

Note: The maximum compressive pressures are indicated by red, and the maximum
tensile pressures are indicated by blue. The maximum pressure values tend to dominate
in the foot bones and the shaft of the tibia and fibula which have been circled in yellow.
Muscle pressure propagation can be observed more specifically in Figure 3.12.
Pressure is observed to have a long duration of high tensile pressure in both the contours
and pressure plots in each case. In cases 1 and 3, the peak compressive pressure is much
higher than Case 2. While in Case 2, the maximum locations of pressure are seen around
the bone areas rather than dispersed throughout.
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Muscle pressure contours (MPa) from each case from 0.45 ms to 2.70 ms.

Note: Transverse cuts of the muscle were also taken as seen in the contours, and the average pressure was plotted to the right of its
respective case. The muscle seen here represents the lower leg and foot muscles and is not torn in this image.

Figure 3.12
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Further investigation of the blast wave interactions in each case is shown in
Figure 3.13. The magnitude of displacement is shown in each case. Similar trends can
be seen in Cases 1 and 3 with displacement occurring horizontally through each material
in the leg and then proceeding vertically. While in Case 2, displacement is observed in
the bone first, and then it disperses outward from the bone.

Figure 3.13

Displacement magnitude contours in all materials.
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3.3.5
3.3.5.1

Land Mine Case
Source Point Location Analysis
The location of the source point of the blast wave greatly influences the outcome

of injuries. The pressure in the tibia along the line of blast wave propagation was
investigated to gain a better understanding of different points of detonation (Figure 3.14).
The peak compressive pressures observed in the tibia are highest during the heel
detonation and lowest during the toe detonation.
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Figure 3.14

Pressure plots in the tibia at three transverse cuts and three different source
point locations.

Note: (A) Pressure in tibia along direction of blast loading after heel detonation; (B)
Pressure in tibia along direction of blast loading after mid foot detonation; (C) Pressure in
tibia along direction of blast loading after toe detonation.
3.3.5.2

Pressure Profile Analysis
Three different pressure profiles were subjected to the lower extremity at the land

mine case, Case 2. These simulations varied in peak pressure and duration. The pressure
in the fibula and tibia was evaluated at the same three transverse cuts and the results can
be seen in Figure 3.15 and Figure 3.16, respectively. The highest pressures were
observed during the mid intensity, long duration (ML) case in both the fibula and tibia.
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The high intensity, short duration (HS) case had the greatest fluctuation in pressures in
both fibula and tibia.

Figure 3.15

Pressure plots in the fibula at three transverse cuts and three different
blasts.

Note: HS = High intensity, short duration, ML = Mid intensity, long duration, LM =
Low intensity, mid duration blast loading. 1-3 refer to the transverse cuts in Figure 3.14.
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Figure 3.16

Pressure plots in the tibia at three transverse cuts and three different blasts.

Note: HS = High intensity, short duration, ML = Mid intensity, long duration, LM =
Low intensity, mid duration blast loading. 1-3 refer to the transverse cuts in Figure 3.14.
3.4

Discussion
The current study is a “first order” study, which provides understanding of how

blast waves interact with the lower extremity leading to primary blast injuries. The
results from our FE simulations show the complexity of pressure wave propagation and
stress-strain states in the lower extremity after being subjected to a blast wave.
Verification of the model was achieved through a mesh refinement study, which showed
equivalent results between different mesh qualities (Figure 3.4D).
3.4.1

3Dimensional Complexity of Stress Waves in the Lower Extremity
The pressure results provide adequate confirmation that a blast simulation

procedure was accurately implemented. High frequency pressure waves were observed
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in skin, muscle, and bone, with pressures varying from positive to negative in short time
spans. When comparing the different cases, the propagation difference in Case 2 is most
likely caused by the close proximity of the source point causing localization of pressure
in the foot (Figure 3.6). The absence of pressure damping in Case 2 might also be due to
the smaller initial surface area of skin compared to the much larger initial surface areas in
Cases 1 and 3, in additional to the geometry through which the stress waves have to
propagate through.
The strength and 3D complexity of the resulting pressure inside each material
depends on the material properties, geometry, and incident blast wave conditions (Cullis
2001). The stiffness of bone is much greater than that of skin and muscle, making its
response to loading extremely different. While muscle and skin have a more similar
elastic modulus, the natural loading they experience is very different. These issues make
the response of each material in the lower extremity extremely unique to one another.
The lower extremity has incredibly complex geometry with many asymmetries. Studies
of blast loading in the head have stated that these factors can generate shear waves in the
materials (Gupta et al. 2013). Our finding that the von Mises stress was an order of
magnitude higher than the normal forces could be attributed to the highly complex
material properties and non-uniform blast loading on the geometry associated with the
lower extremity (Figure 3.8).
The cyclic changes between compressive and tensile states were observed in all
materials; however, bone tended to have the highest pressures and most abundant
oscillations when compared to muscle and skin (Figure 3.6 and Figure 3.10). These
complex oscillations could be a cause of frequent bone fractures due to explosions and
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due to the high stiffness of bone. The short period of high compressive pressures and a
long duration of tensile pressure observed in muscle and skin might be associated with
compartmental pressure build up, which is explained more in detail in the “implication to
compartmental syndrome” sub-section. Tensile strains are often more damaging to tissue
than compression due to water in the tissue resisting compression while tensile forces
directly disrupt these bonds (Xi et al. 2001, Gupta et al. 2013).
3.4.2

Implication to Fractures and Amputations
In past studies amputations were assumed to occur from flailing at the joint (Hull

et al. 1996); however, more recently amputations have been associated with the primary
blast and found that bones were fractured in the shafts rather than at the joints (Hull et al.
1996, Neuhaus et al. 2006). Although bone fractures occur at much greater peak
overpressures than the ones exhibited here, our results also found that the maximum
tensile and compressive pressures occur in the shaft of the bone. In addition, we found
that maximum pressures occur in the foot bones, which are also common sites of injury
(Ramasamy et al. 2011).
3.4.3

Implication to Compartment Syndrome
Finding muscle failure exclusively in our model could link primary blast effects to

compartment syndrome found in patients with no other apparent injuries. Compartment
syndrome occurs when the average pressure in any closed space in the body falls below
the intracompartmental pressure (Ramasamy et al. 2009). This syndrome is commonly
associated with fracture, tissue loss, and burns; however, recently primary blast injury has
been directly associated with the explanation for delayed compartment syndrome
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(Ritenour et al. 2008). The diagnosis of compartment syndrome is often extremely
difficult (Shadgan et al. 2010), and one of these reasons could be due to the direct
mechanical stress caused in muscle tissue by the blast wave.
Looking specifically at the muscle, we observe longer durations of high tensile
pressure (which are lower than the muscle’s native intracompartmental pressure), or
expansion, in the contours and pressure plots in each case (Figure 3.12). Additionally,
when a muscle cell becomes stretched or exposed to tensile pressure it is extremely
vulnerable and usually tends to leak contents out of the cell due to a structural
compromise to the cell membrane, and causes muscle swelling (Better et al. 2003, Gillani
et al. 2012). As previously mentioned, tension effects are often more damaging to tissue
than compression due to the water in tissue resisting compression while tension can more
directly disrupt the tissue (Xi et al. 2001, Gupta et al. 2013). This damage from direct
pressure or crushing is usually termed crush syndrome eventually leading to compartment
syndrome. The pressure propagation from a compressive to tensile state could cause
stretching of the muscle cells eventually inducing muscle swelling and a build-up of
pressure. Although our findings may indicate a high probability of compartment
syndrome occurring, additional information is needed in our model for making a
definitive conclusion regarding compartment syndrome.
3.4.4

On the Injury Pattern of the Landmine Case
Case 2, the landmine case, is seen on the battlefield to cause the most devastating

injuries to soldiers and civilians. With an extremely large pressure being released
directly under the foot, complex injuries are seen (Figure 3.6, Figure 3.10, and Figure
3.12). This is where a model like ours would have a large impact on the improvement of
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personal protective equipment such as boots made of materials which can dampen the
blast wave. From the FEA results, it is seen that pressure and displacement dominate in
the bone compared to the other cases (Figure 3.6 and Figure 3.9). These results were also
seen to vary with intensity and duration of the pressure wave.
Previous literature shows that there is full tissue disruption near the foot, but as
the wave travels up the leg the speed of the wave is adjusted to the medium which can
cause less apparent damage at the cellular level and between major structures (Bergeron
et al. 2002). The complete destruction in the foot is due to the splitting effect of the
material, which largely depends on the amount of explosive. Our simulations confirmed
that the propagation and injury zone is highly dependent on the point of impact of the
foot. For example, the outcome of a heel detonation would be completely different than a
big toe detonation.
With the stresses and displacements dominating in the bone, we observe that the
other tissues response depends highly on the bone. Our simulations show the pressure
wave propagates vertically through the bone, and then propagating outward into the
surrounding tissues (Figure 3.13). This can be correlated with the splitting effect zone
having a high dependence on the distal location of bone damage (Bergeron et al. 2002).
The large difference in densities at the bone and muscle interface can cause disruption
and ultimately removal of the tissue from the lower extremity. When compared to the
other cases, the wave has more interaction with skin and muscle prior to bone allowing
more damping and thus less damage to occur.
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3.5

Conclusions
Overall, this paper focused on obtaining a detailed lower extremity model and

subjecting it to several blast scenarios. Once the lower extremity simulations were
performed, the main objectives were to obtain proper pressure wave propagation, analyze
and compare three different source point cases, and compare the results with primary
blast injuries observed in literature. All three goals were accomplished, each bringing
different insight into the lower extremity response to blast waves. The main findings can
be summarized as follows:
1.

This study allowed us to focus on the fundamental features of our lower
extremity mesh and blast wave simulation procedure. Even though the
lower extremity model was simplified, the model was verified (Figure
3.4D, Figure 3.5, and Table 3.1), and the results are relevant for gaining an
understanding of the blast wave interactions in each material and provide a
foundation for further studies (Figure 3.6, Figure 3.10, and Figure 3.12).

2. The landmine case results varied significantly from the other cases with
the stresses and displacement dominating in the bones which provides
evidence for the complete tissue disruption commonly observed on field
(Figure 3.6, Figure 3.10, Figure 3.12, and Figure 3.13).
3. Recently, amputations and compartmental pressure have been correlated
with primary blast injuries exclusively (Hull et al. 1996, Ritenour et al.
2008, Wolf et al. 2009). In our analyses muscle was the only material
found to reach failure levels in the simulation when compared to published
UTS data (Table 3.2); this finding could be correlated with the
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classification of compartment syndrome as a primary blast injury. If
muscle necrosis occurs without failure in other tissues, blast overpressure
might be a contributing factor to the syndrome.
4. Bone pressure propagation was confirmed to dominate in the shaft of the
long bones and in the foot bones (Figure 3.11). Finding von Mises (shear)
stress an order of magnitude higher than principal stress might be
associated with the common occurrence of fractures due to the strength of
bone being much weaker in shear compared to tension and compression
(Turner et al. 2001). In addition, fluctuations between compressive and
tensile states were also observed as a possible contributing factor to
common occurring fractures.
Although there are currently no experimentally validated models for blast effects
on the lower extremity, this is a first and critical step towards developing an ultimate
model that, after experimental validation, will allow the military to obtain injury criteria
data and optimize personal protective equipment with a shorter cycle of development.
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CHAPTER IV
ANTI-VEHICULAR (UNDERBELLY) BLAST FINITE ELEMENT ANALYSIS AND
VALIDATION

4.1

Introduction
Military personnel injuries and fatalities in vehicles are an increasing concern in

the United States due to the use of IEDs or Anti-Vehicular land mines on the battlefield
becoming extremely common. This occurrence can be referred to as an anti-vehicular
blast, under-vehicular blast, underbelly blast, or underbody blast. The vehicle’s structure
absorbs some of the blast, but most of it is transferred to the vehicle. The amount of
loading transferred depends on the size of the vehicle and explosive. Heavy vehicles can
produce accelerations beyond 500g with positive durations on the order of 2 to 5 ms,
while light vehicles can produce accelerations averaging 100g with positive durations of
3 to 100 ms (Perry et al. 2014).
Due to lower extremities being in direct contact with the floor of vehicles, the
lower extremities account for a majority of the injuries during underbelly blasts
(Nilakantan et al. 2009, Ramasamy et al. 2011, Masouros et al. 2012). These injuries can
be seriously fatal, severe, and debilitating. For the most part, the lower extremity injuries
are due to axial loading of the limb, and the amount of loading depends on the explosive
and vehicle. In enclosed blast situations, such as an underbelly blast, foot bone injuries
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account for 35.6% of all skeletal injuries and tibia/fibula injuries account for 45.8% of all
skeletal injuries, while the femur accounts for only 10.1% of all skeletal injuries.
Although experimental studies have been performed to advance these
understandings (Arepally et al. 2008, Nilakantan et al. 2009, Ramasamy et al. 2011,
Bailey et al. 2013, Perry et al. 2014), the reported loading conditions, test specimen type
(cadaver, ATD, etc.), and injury thresholds vary significantly. Due to the difficulty in
this type of experimental testing and large range of tests which need to be conducted on
PPE and vehicle structures, computational analysis has become an increased area of
interest. Limited progress has been made in computational analysis of underbelly blasts
on the lower extremity. The effects of foot position and material properties also need to
be investigated. How the person’s foot is positioned when loaded can greatly affect the
outcome of injuries (passenger versus driver). There is also a large variation in bone
mechanical properties with age of specimen and rate of loading (Evans 1976, McElhaney
1996, Ding et al. 1997).
In the previous chapter, a realistic Finite Element (FE) model of the lower
extremity in a standing posture was developed and subjected to blast loading directly. In
this study, the model was converted to a sitting position in order to simulate an in-vehicle
blast evaluation. As a source of model validation, experimental cadaver drop tower
testing was conducted at the University of Michigan Transportation Facility. This testing
allowed for characterization of the lower extremity’s impact response to high-rate vertical
loading, a situation with similar loading conditions as an underbelly blast. These results
will be compared to the results found in our simulations. The goal of this chapter is to
validate our FE model in order to provide evidence of the value and importance of
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simulation work for enhancing the understanding of blast waves within the lower
extremity. The damage incurred on the lower extremity due to high rate axial loading will
be investigated with varying loading conditions, bone material properties, and foot
position. The data obtained can also be used to enhance the energy absorbing structures
in military vehicles and PPE.
4.2
4.2.1

Methods
Experimental Drop Tower Testing of Cadaver Lower Extremities
Our collaborators at the University of Michigan Transportation Research Institute

(Rupp et al. 2012) performed experimental vertical drop tower testing as a source of
validation for our lower extremity model. Testing was performed on two whole cadavers
and two sets of cadaver lower extremities. The testing device consisted of a sled that
dropped vertically from the ceiling to the floor (Figure 4.1). The sled impacts a set of
surfaces with force-deflection features which allows two target impact pulses of
approximately 250g and 350g to be produced. One whole cadaver and one lower
extremity specimen from each set were tested at each pulse.
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Figure 4.1

Experimental drop tower testing setup.

The superstructure is used to position the specimen’s pelvis on a hard seat, and
the specimen’s feet are positioned on an impact plate that moves independently of the
main fixture. An anvil located below the footplate is used to apply load to the feet, and
an impact surface aligned with the perimeter of the sled frame applies loads to the pelvis
through a rigid flat seat. The drop height of the platform and the amount of padding on
the impact surfaces were varied to achieve the target acceleration pulses at the footplate.
Drop height for the 250g tests was 2.0 m while the drop height for the 350g tests was 2.6
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m. Three 2000g uniaxial accelerometers (Endevo model 7264G) were mounted to the
base plate near the foot.
The test specimens and test matrix are described in Table 4.1. Accelerometers
were attached to the upper and lower sections of the tibias, and the distal portions of the
femurs, and the acceleration was recorded for 0.03 s. An example of a setup for a single
lower extremity can be seen in Figure 4.2 and a whole leg can be seen in Figure 4.3.
Each test was recorded using four high-speed digital video cameras at 1000 frames/s.
Posttest autopsies were performed on each specimen and documented.
Table 4.1

Test Specimens and Test Matrix

Test ID

Sex
M

Age Stature Mass Cause of Death Specimen
(yr) (cm)
(kg)
Type
79
178
102 Diabetes
Right LX

Impact
Condition
250g @ 2.5m/s

MS1201R
MS1201L

M

79

178

102

Left LX

350g @ 2.5m/s

MS1202R

M

30

173

59.0 Brain Cancer

Right LX

250g @ 2.5m/s

MS1202L

M

30

173

59.0 Brain Cancer

Left LX

350g @ 2.5m/s

MS1203

M

50

170

70.3 Throat Cancer Whole body 250g @ 2.5m/s

MS1204

M

76

170

82.1 Congestive
Heart Failure

Diabetes

60

Whole body 350g @ 2.5m/s

Figure 4.2

Example of pre-test setup of single lower extremity test

(Test ID = MS1201R).
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Figure 4.3

Example of pre-test setup of whole body test

(Test ID = MS1203).
62

4.2.2

Mesh Development of Seated Posture Lower Extremity
For this portion of the study, the previous lower extremity model was manually

and semi-automatically segmented, rotated, and aligned in order to develop a seated
posture of the lower extremity with the foot resting flat against the floor and a seated
posture of the lower extremity with only the heel of the foot resting on the floor. The
previous geometry of the lower extremity was developed from axial computed
tomography scans and cryosections contained from the National Library of Medicine’s
Visibile Human Male.
In order to reposition the lower portion of the lower extremity, the lower leg
muscles, tibia, fibula, foot bones, and foot muscles had to be rotated to the correct angle.
Once these were rotated to the correct angle relative to the thigh region of the lower
extremity, they needed to be re-aligned with the femur/knee. Once all of the lower leg
components are placed correctly, a copy of the skin mask was created and rotated and
aligned the same amount as the lower leg components. Using Boolean (add and subtract)
operations and manual (paint) segmentation tools, a new skin mask was created for the
new lower extremity position.
The FE models were then meshed in ScanIP. The lower extremity was simplified
for the first set of simulations. It contained the following parts: contour (skin and fat),
femur, patella, tibia, fibula, foot bones, calf muscles, tibialis/proneus/extensor muscles,
and foot muscles.
4.2.3

Finite Element Analysis and Validation
Using Abaqus/Explicit, simulations were performed by applying impact pulses of

approximately 250g and 350g to a plate positioned below the lower extremity. These
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pulses were obtained from the averages read on the experimental drop tower testing foot
plate and can be seen in Figure 4.4. The same elastic material properties from literature
were used for the skin, bone, and muscle as in Section 3.2.3. The contact definition
between materials was fixed due to our findings in Section 3.3 that this has little effect on
the results at such high rates.

Figure 4.4

4.2.4

Acceleration loading pulses used in FE drop tower simulations.

Identification of Boundary Conditions and Loading
The boundary conditions and loading were difficult to identify precisely due to

the complex experimental setup and the fact that a different school performed the
experiments. Several setups were simulated varying the boundary conditions and
loading. The main setups of the different simulations that were performed can be seen in
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Figure 4.5. Modeling of the foot plate was also put into consideration. The plate was
modeled using a rigid body, and its placement was varied. A simulation using Setup A
was modeled with no gap between the foot and foot plate, and it was also modeled with a
3 mm gap between the foot and foot plate. Both simulations defined a hard contact
interaction between the foot and footplate. Due to the results which will be seen later, all
subsequent simulations were executed with a 3 mm gap.

Figure 4.5

Setups of the different boundary and loading conditions applied in the FE
drop tower simulations.

In Figure 4.5A, an acceleration pulse was applied to the plate. In Figure 4.5B, an
acceleration pulse was applied to the plate and the lower extremity contour was fixed at
the seat. In Figure 4.5C, an acceleration pulse was applied to the plate and a
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displacement was applied at the seat. In Figure Figure 4.5D, an acceleration pulse was
applied to the plate, the lower extremity contour was fixed at the seat, and the lower
extremity contour was fixed in the x-direction and z-direction at the foot. In Figure 4.5E,
an acceleration pulse was applied to the plate, the lower extremity contour was fixed at
the seat, and the lower extremity contour and foot bones were fixed in the x-direction and
z-direction at the foot. For each simulation the acceleration in the lower tibia, upper tibia,
and distal femur were evaluated and compared to the experimental drop tower testing.
The stresses were also evaluated and compared to the experimental drop tower testing
and injury data from previous findings.
4.2.5

Variation of Bulk Viscosity Damping Factors
Prior to simulating every variation of the boundary and loading conditions being

applied, the setup in Figure 4.5A was simulated several times varying the bulk viscosity
damping factors. The different factors simulated can be seen in Table 4.2. There are two
forms of bulk viscosity, linear and quadratic, and their purpose is to improve the
modeling of high-speed dynamic events. Since the results obtained in Setup A were
similar to the results found in the experiments but they seemed to be dampened, it was
thought that the damping might be the cause of the altered results.
Table 4.2

Test matrix for simulations ran varying linear and quadratic damping
parameters

Run Number
1
2
3
4

Linear
0.06
0.6
6
0
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Quad
0.12
1.2
12
0

A small amount of viscosity is included by default. The linear damping
coefficient is 0.06 and the quadratic damping coefficient is 1.2. These values are
appropriate for most models but can be modified. This damping is associated with
volumetric straining. Linear bulk viscosity dampens the oscillations that appear in the
pressure wave, and the bulk viscosity spreads the wave over several elements. The linear
bulk viscosity produces a bulk viscosity pressure that is linear in the volumetric strain
rate. The form is as follows:
𝑝𝑏𝑣1 = 𝑏1 𝜌𝑐𝑑 𝐿𝑒 𝜖̇𝑣𝑜𝑙

(4.1)

where 𝑏1 is the linear damping coefficient, 𝜌 is the material density, 𝑐𝑑 is the current
dilatational wave speed, 𝐿𝑒 is the element characteristic length, and 𝜖̇𝑣𝑜𝑙 is the volumetric
strain rate. The quadratic viscosity produces a seconf form of bulk viscosity pressure
which is applied only if the volumetric strain rate is compressive. This form is as
follows:
𝑝𝑏𝑣2 = 𝜌(𝑏2 𝐿𝑒 𝜖̇𝑣𝑜𝑙 )2

(4.2)

where 𝑏2 is the quadratic damping coefficient and all other quantities are as defined in
Equation 4.1. An overview of how the linear and quadratic damping coefficients affect
the pressure wave can be seen in Figure 4.6.
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Figure 4.6

Bulk viscosity damping parameters effects on pressure on mesh.

Note: Adapted from Abaqus.
4.2.6

Alteration of Military Personnel Foot Position
The position of the foot in a vehicle is highly dependent on the role of the military

personnel in the vehicle. The two most common positions are full contact and heel only
contact with the floor of the vehicle (Figure 4.7). The position of the foot can highly alter
the results of the stresses found in the lower extremity, and this factor will be investigated
in this study by having two foot position meshes. The 350g case will be simulated in
Abaqus/CAE using the Setup A in Figure 4.5. The material properties, contact
interactions, and plate modeling were the same as in Section 4.2.3.
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Figure 4.7

4.2.7

Foot position variation in vehicles. Position 1 = full foot contact and
Position 2 = heel only foot contact.

Analysis of the Influence of Bone Material Properties Based on Specimen
Age
After analyzing the experimental drop-tower testing, it was found that the femur

was the only bone which fractured. This finding does not match well with injuries in
literature (Arepally et al. 2008, Ramasamy et al. 2011), stating that the tibia and foot
bones are the most commonly injured. Reviewing the data from the experimental testing,
it was found that injuries occurred in older cadaver subjects. Due to this finding, the
bone material properties will be altered to consider the factor of old versus young bones
and incorporated into the under belly blast simulations. Investigating the effects of bone
material properties on the results is extremely important when using cadaver subjects as a
source of validation. The bones were modeled with an elastic modulus of 150 GPa, 50
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GPa, and 15 GPa. With extreme stiffness differences, an understanding of how much the
material response affects the results can be obtained. These simulations were performed
using the 250g acceleration pulse and Setup A (Figure 4.5).
It is important to note that the ultimate tensile strength (UTS), ultimate
compressive strength (UCS), and ultimate shear strength (USS) vary from source to
source, with age of specimen, and with strain rate. A summary of these values can be
seen in Table 4.3. It was seen that UCS ranged from 365-50, UTS ranged from 133-50,
and USS ranged from 68-51.6. Bone is strongest in compression and weakest in shear. It
appears from the table that the strength of bone was affected more by the age of the
specimen than the modulus (Evans 1976). Bone also showed differences from fresh to
embalmed specimens (McElhaney 1996). This table will be considered when looking at
the maximum stresses.
Table 4.3
Reference

Summary of bone modulus and ultimate strengths.

Specimen
Type
(Evans 1976)Embalmed
human
(Evans 1976)Embalmed
human
(Turner et al. Frozen
2001)
human
(Reilly et al.
---1975)
(McElhaney Fresh
1996)
bovine
(McElhaney Fresh
1996)
bovine
(McElhaney Embalmed
1996)
human
(McCloskey
---et al. 2014)
(Yamada et
---al. 1970)

Specimen Strain
Age
Rate
Younger
---(Avg. 41.5)
Older (Avg
---71)
63-83
-------

UTS
(MPa)
100.7

14,715

75.8

----

Modulus
(MPa)
17,331

----

----

----

133-51

UCS
(MPa)
----

USS
(MPa)
----

----

----

---193-133

51.6
68

3

.001/s

18,616

----

176

----

3

1500/s

42,058

----

365

----

24

1500/s

40,679

----

317

----

280-50

----

302-151

----

----

----

----

----

21,000-5,000 70-50
----
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146-140

4.2.8

Bone Damage Incorporation
A simplified failure model for bone was also incorporated into a simulation.

Plastic data and ductile damage were used from literature (Keong 2011)and can be seen
in Table 4.4. The 350g case was used to evaluate failure in the model. The acceleration
pulse was applied at the plate, and the hip and foot were fixed as mentioned previously in
Setup E (Figure 4.5). The other material properties were kept consistent with Section
4.2.3.
Table 4.4

Parameters for failure criteria of bone.

Material

Failure Model
Plastic
Yield
Plastic
Stress
Strain
(MPa)
120
0
125
0.01
130
0.035

Bones

Ductile Damage
Fracture
Stress
Strain Rate Displacement
Strain
Triaxiality
at Failure (mm)
0.035

0.333

0.03

0.175

The damage capabilities in Abaqus allow the damage to occur within the finite
elements. When damage occurs and the specific failure criterion is reached, the load
carrying capacity of the elements drops to zero and the element deletes. The progressive
path of the damage modeling can be seen in Figure 4.8. First there is the undamaged
constitutive behavior described by the elastic-plastic definition. Next the damage
initiation occurs at point A. From point A to point B, damage evolution occurs which
leads to element removal and failure point B. Damage initiation refers to the fracture
strain, and damage evolution refers to the displacement at failure. If damage evolution is
not specified no failure will occur in the model. The ductile damage criterion assumes
71

the equivalent plastic strain at the onset of damage is a function of stress triaxiality and
strain rate. Stress triaxiality is defined as:
𝜂 = −𝑝/𝑞

(4.3)

where p is the pressure stress and q is the von Mises stress.

Figure 4.8

Typical material response showing progressive damage in Abaqus.

Note: Point A is equivalent to the damage initiation criterion. Point B is equivalent to
the damage evolution criterion. Adapted from Abaqus.
4.3
4.3.1

Results
Experimental Drop Tower Testing
A summary of the cadaver descriptions and injuries from testing can be seen in

Table 4.5. From the experimental drop-tower testing, the autopsies found injuries only in
350g impact severity tests. In the 350g cases, both legs in the whole body test (Test ID =
MS1204) and one single lower extremity test (Test ID = MS1201L) had mid-shaft femur
fractures occur (Figure 4.9). No injuries were reported in the tibia, fibula, or foot bones
in any cases. It is important to note the age of the specimens correlated with injury.
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Looking at the age of the specimens, the lower extremity specimen that did not fail in the
350g testing was at least 46 years younger than the specimens which did fail.

Table 4.5
Test ID

MS1201R
MS1202R
MS1203
MS1201L
MS1202L
MS1204

Summary of test specimens, injuries, and peak acceleration at the footplate,
tibia, and femur from the experimental drop tower testing.
Specimen
Type

Age

Impact Injury
Severity Outcome

Right
Lower
Extremity
Right
Lower
Extremity
Whole
Body
Left Lower
Extremity

79

250g

No injury

Avg. Lower Upper Femur
Foot Tibia Tibia
Plate
261 227
220
176

30

250g

No injury

271

320

338

194

50

250g

No injury

271

79

350g

364

228
270
476

163
186
298

Left Lower
Extremity
Whole
Body

30

350g

Mid-shaft
femur
fracture
No injury

286
281
407

366

409

432

258

76

350g

Bilateral
mid-shaft
femur
fracture

445

325

274

187

251

286

185
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Peak Acceleration (g)

Figure 4.9

Autopsy results found a mid-shaft femur wedge fracture in 2 out of 3 of the
350g experimental drop tower tests.

Note: (A) Illustration of mid-shaft femur wedge fracture and (B) Images of MS1201L
mid-shaft femur wedge fracture.
Next the injury data, acceleration, and images from testing were analyzed to try
and determine why the injuries occurring in the University of Michigan’s tests were
different than those observed on the field and in other experimental tests found in
literature. In literature the majority of injuries focus on the foot and tibia/fibula
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(Dougherty et al. 2009, Kraft et al. 2011, Ramasamy et al. 2011). Most papers do not
even mention the femur.
The acceleration at the footplate was recorded at three different points on the
plate. An average of the peak acceleration in the footplate along with the peak
accelerations read on the tibia and femur can be found in Table 4.5. Comparing the peak
accelerations in the plate of each test, it is observed that the peak accelerations in the
plate are similar in the 250g cases; however, the peak acceleration in the whole body
350g case is much higher than the single leg tests. Looking at the plots of the
acceleration in the 250g cases (Figure 4.10), the values read at the center of the plate are
approximately 50g higher than the left and right of the plate. In the 350g case (Figure
4.11), the center of the plate is approximately 80g higher than the left and right of the
plate. When comparing the peak accelerations in the footplate from tests where injuries
occurred (Test ID MS1201L and MS1204), the values appear to vary drastically (having
almost a 100g difference between the average peak acceleration on the footplate).
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Figure 4.10

Acceleration data recorded at the left, center, and right of the footplate
during the 250g tests.

Note: The label in the legend before the location on the footplate refers to the Test ID.

Figure 4.11

Acceleration data recorded at the left, center, and right of the footplate
during the 350g tests.

Note: The label in the legend before the location on the footplate refers to the Test ID.
In the 250g cases, the lower and upper tibia maximum peak acceleration
difference between test subjects was approximately 100g; however, the rate of increase in
acceleration has the same trend at initial loading in all tests (Figure 4.12 and Figure 4.13).
The femur maximum peak acceleration difference between test subjects was
approximately 30g, and the rate of increase in acceleration has the same trend at initial
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loading in all tests (Figure 4.14). The whole body test observed a peak acceleration
difference between the right and left leg of approximately 20g in the femur, but no
significant difference in the tibias.

Figure 4.12

Acceleration data recorded on the lower tibia in the 250g cases.

Note: The label in the legend refers to the Test ID. R = Right leg and L = Left leg.
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Figure 4.13

Acceleration data recorded on the upper tibia in the 250g cases.

Notes: The label in the legend refers to the Test ID. R = Right leg and L = Left leg.

Figure 4.14

Acceleration data recorded on the femur in the 250g cases.

Notes: The label in the legend refers to the Test ID. R = Right leg and L = Left leg.
In the 350g cases, the lower and upper tibia maximum peak acceleration
difference between tests subjects was approximately 150g and 200g respectively. The
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femur maximum peak difference between subjects was approximately 100g. The whole
body test observed a peak acceleration difference between the right and left leg of
approximately 125g in the lower tibia, but no significant differences between the upper
tibias and femurs. The 350g whole body peak accelerations were consistently lower in
the bones than single leg tests, even with higher footplate peak acceleration. The rate of
increase in acceleration has almost the exact trend at initial loading in the tibia and
femurs except in test MS1201L. The rate (slope) is the same, but when the acceleration
occurs is delayed approximately 1.5 ms (Figure 4.15, Figure 4.16, and Figure 4.17).

Figure 4.15

Acceleration data recorded on the lower tibia in the 350g cases.

Notes: The label in the legend refers to the Test ID. R = Right leg and L = Left leg.

79

Figure 4.16

Acceleration data recorded on the upper tibia in the 350g cases.

Notes: The label in the legend refers to the Test ID. R = Right leg and L = Left leg.

Figure 4.17

Acceleration data recorded on the femur in the 350g cases.

Notes: The label in the legend refers to the Test ID. R = Right leg and L = Left leg.
When looking specifically at the femur, the peak accelerations observed on the
femurs with injuries occurred at a range of values, from 185g to 298g. Multiple tests
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with no injuries, at both 250g and 350g, had peak accelerations which occurred in the
middle of that range. The whole body 350g test sequence images can be seen in Figure
4.18. It is important to note that little displacement occurs between 0 and 10 ms (the area
of interest for our simulations). The test is carried out for much longer, during which
more displacement occurs. The fixation at the seat is also important to note. The amount
of rotation allowed at the hip joint is unknown, which could be a factor in the femur
fractures. It is also important to note that the footplate is not kept level throughout the
entire experiment.
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Figure 4.18

Lateral image sequence of MS1204 whole body test at 350g.
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4.3.2

Validation Simulations
The simplified version of the lower extremity and masks used to create the final

mesh can be seen in Figure 4.19. The final mesh used in the drop tower simulations
contained 2.3 million elements and can be seen in Figure 4.20. The mesh includes all of
the bones, the lower leg and foot muscles, and the contour.

Figure 4.19

ScanIP masks created for the drop tower FE simulations.

Figure 4.20

Mesh created for the drop tower FE simulations.
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4.3.2.1

Footplate Placement Relative to Foot
The results from the simulations varying in placement of the footplate can be seen

in Figure 4.21. With no gap between the foot and footplate, the acceleration in the lower
tibia increased before the acceleration in the tibia of the simulation with a 3 mm gap
between the foot and footplate; however, the peak acceleration of the no gap simulation
was much lower than the peak acceleration of the 3 mm gap simulation. The no gap
simulation also failed due to excessive deformation in elements of the skin which were in
direct contact with the plate. After comparing the results, it was concluded that the 3 mm
gap placement would be used in subsequent simulations.

Figure 4.21

Lower tibia acceleration from FE simulations comparing placement of
footplate to experimental data in 250g case.
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4.3.2.2

Bulk Viscosity Damping Factor Effects
Since the Setup A results of the lower tibia acceleration data displayed a similar

trend to the experimental results, but appeared to be damping in Figure 4.21, it was
important to investigate the effects of the bulk viscosity on the simulation. The
acceleration results in the lower tibia from the simulations that varied the linear and
quadratic bulk viscosity terms can be seen in Figure 4.22. Little variation can be seen in
the data, with most of it overlapping. After comparing the results it was decided that the
bulk viscosity parameters would not be altered in further simulations.

Figure 4.22

4.3.2.3

Lower tibia acceleration from FE simulations comparing bulk viscosity
variation runs with experimental data in 250g case.

Influence of Bone Material Properties Based on Specimen Age
Three extreme conditions for the Young’s modulus were simulated in order to

gather an understanding of how the stiffness of bone (young versus old bone) affects the
results. The results for three different moduli can be seen in Figure 4.23. With an
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increase in modulus, the initial rate of increase in acceleration in the tibia was increased
and the peak also increased. The rate did not change much and the peak increased
approximately 25g. The E=50000 run was cancelled in order to save computational time,
since it appeared to be falling in the middle of the other two runs. It was determined
from these results that the modulus did not greatly affect the data in the tibia and
subsequent simulations would use a Young’s modulus of 15,000 MPa. The influence of
bone ultimate strength values based on specimen age on ultimate strength values of bone
will be considered in the next section of the results.

Figure 4.23

4.3.2.4

Lower tibia acceleration from FE simulations comparing Young’s Modulus
of bone to experimental data in 250g case.

Boundary Conditions and Loading
A summary of the acceleration read in the lower tibia from the simulations

varying in boundary conditions and loading setup can be seen in Figure 4.24. The
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simulation with plate acceleration only (Setup A) gave results with similar peak
acceleration, but the rate of increase in acceleration was dampened. Setup B (fixed at hip
and plate acceleration) decreased the peak acceleration. The simulation which
incorporated displacement conditions at the hip (Setup C) increased the acceleration
much sooner than what occurred in the experiments. Due to these results seen early on in
the simulations, the jobs were killed to save computational time. Adding fixed boundary
conditions at the hip and top surface of the foot (Setup D) shifted the rate of increase in
acceleration towards the experimental results and also increased the peak some. Last, the
simulation applying acceleration loading at the plate and fixed boundary conditions at the
hip, top of the foot, and foot bones (Setup E) gave acceleration results in the lower tibia
with a rate of increase similar to that of the experiments, but it also gave higher peak
acceleration than the experiments.
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Figure 4.24

Lower tibia acceleration from FE simulations comparing the alteration in
boundary conditions and loading setup to experimental data in 250g case.

Note: Setup A = acceleration at footplate only, Setup B = fixed at hip and acceleration at
footplate, Setup C = Displacement at hip and acceleration at footplate, Setup D = fixed at
hip and surface of top of foot and acceleration at footplate, and Setup E = fixed at hip,
surface of top of foot, and foot bones and acceleration at footplate.
After comparing the boundary conditions/loading setup results, a conclusion was
drawn. Setup A (acceleration only) and Setup E (fixed at hip, foot surface, and foot
bones) would both be simulated for 250g and 350g cases. Both were simulated since the
results showed that the extreme boundary condition variation bounded the results due to
the limitations of knowing exactly how much the foot and hip were allowed to move
during the experimental testing. The undeformed and deformed configurations resulting
from the two setups for the 250g loading can be seen in Figure 4.25. Here we see that
Setup A allowed the foot to move independently of the plate allowing for lots of rotation,
while Setup E did not.
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Figure 4.25

Undeformed and deformed configurations of the lower extremity
comparing Setup A and Setup E.

Note: (A) Undeformed, (B) Deformed after 250g loading in Setup A, and (C) deformed
after 250g loading in Setup E.
The Setup A and E averaged FEA results compared to the experimental results in
the tibia and femur for the 250g case can be seen in Figure 4.26, Figure 4.27, and Figure
4.28, and the FEA results compared to experimental in the tibia and femur for the 350g
case can be seen in Figure 4.29, Figure 4.30, and Figure 4.31. The results demonstrated
good agreement with experimental results showing similar trends in initial rises in
acceleration and maximum peaks. The average of Setup A and E were plotted along with
the standard deviation. Contour plots of the acceleration in the bone can be seen in
Figure 4.32, further confirming overall propagation of the acceleration through the lower
extremity.
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Figure 4.26

Lower tibia acceleration data comparison of FE versus experimental results
in 250g case.

Figure 4.27

Upper tibia acceleration data comparison of FE versus experimental results
in 250g case.
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Figure 4.28

Femur acceleration data comparison of FE versus experimental results in
250g cases.

Figure 4.29

Lower tibia acceleration data comparison of FE versus experimental results
in 350g case.
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Figure 4.30

Upper tibia acceleration data comparison of FE versus experimental results
in 350g case.

Figure 4.31

Femur acceleration data comparison of FE versus experimental results in
350g case.
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Figure 4.32

Comparison of acceleration in the direction of loading in the bones between
350g and 250g loading pulses.

The femur stresses were investigated in order to determine if they surpassed
failure as was seen in the experiments. The von Mises stress (Figure 4.33) and pressure
(Figure 4.34) revealed maximum stress in the mid shaft of the femur relative to the other
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portions of femur; however, neither the 250g nor 350g case surpassed average UCS or
UTS values of bone. The 350g case did show higher stresses than the 250g case. Next
the stress in the individual directions was investigated. The stress dominated in the S23
and S33 directions and can be seen in Figure 4.35 and Figure 4.36, respectively. Here it
is seen that the stresses dominate near both ends of the shaft of the bone, but it is
important to note that with the variation of boundary conditions the stress could dominate
in the mid shaft in a different boundary setup (Setup A versus Setup E). The S33 contour
reveals stresses in the 350g case that exceed the UTS strength seen in older specimens
(75.8 MPa) but not younger specimens (100.7 MPa).

Figure 4.33

Comparison of von Mises stress (MPa) in the femur at 6 ms between 350g
and 250g loading pulses.
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Figure 4.34

Comparison of pressure (MPa) in the femur at 6 ms between 350g and
250g loading pulses.

Figure 4.35

Comparison of S23 (MPa) in the femur at 9 ms between 350g and 250g
loading pulses.
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Figure 4.36

Comparison of S33 (MPa) in the femur at 9 ms between 350g and 250g
loading pulses.

Looking at the lower leg bones, it was found in both cases that the von Mises
stress (Figure 4.37) and pressure (Figure 4.38) surpassed the ultimate tensile and
compressive strengths of bone in the foot bones and tibia. This is not consistent with the
experimental results; however it is consistent with results seen in literature.
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Figure 4.37

Von Mises stress (MPa) contours in the lower leg bones.

Figure 4.38

Pressure (MPa) contours in the lower leg bones.
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4.3.3

Foot Position Simulations
The masks created for Position 2 can be seen in Figure 4.39A. The mesh

contained approximately 1.9 million elements (Figure 4.39B). The acceleration was
evaluated at the lower tibia (Figure 4.40), upper tibia (Figure 4.41), and distal femur
(Figure 4.42). The lower tibia had similar acceleration patterns in both positions;
however, more oscillations were observed in Position 2. The upper tibia had a decreased
initial rise in acceleration and lower peak in Position 2. The femur also had a decreased
initial rise in acceleration and the peak was less than half of the peak in observed in
Position 1. To better understand the decrease in acceleration, the magnitude of
displacement was observed in both positions and compared (Figure 4.43). Position 1 has
a larger and faster displacement in the lower leg than Position 2. Position 2 allows for
more rotation in the lower leg prior to displacing portions of the upper leg.

Figure 4.39

(A) Masks in ScanIP and (B) mesh for Position 2 of anti-vehicular foot
position study.
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Figure 4.40

Comparison of the acceleration in the lower tibia at 250g between Position
1 (flat foot) and 2 (heel contact only).

Figure 4.41

Comparison of the acceleration in the upper tibia at 250g between Position
1 (flat foot) and 2 (heel contact only).
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Figure 4.42

Comparison of the acceleration in the femur at 250g between Position 1
(flat foot) and 2 (heel contact only).

Figure 4.43

Isosurface contour plots of displacement magnitude (mm) in Position 1 and
2 at 250g loading.

The stress in the bones was evaluated to further confirm the differences in rotation
of the positions and to determine if any failure would have occurred. When looking at
the lower tibia (Figure 4.44), the stress in Position 1 is dominates in S22 meaning the
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lower tibia is predominantly in a uniaxial stress state. On the other hand, in Position 2
the lower tibia has significant stress in S22, S33, and S23, meaning the lower tibia is
undergoing uniaxial and shear loading due to the rotation occurring. Similar results are
seen in the upper tibia (Figure 4.45). In Figure 4.46, it is seen that the femur experiences
larger shear and uniaxial stress states in Position 1 compared to Position 2. In Position 1,
the von Mises stress (Figure 4.47) in the tibia and fibula surpassed the ultimate strength
of bone. In position 2, the distal end of the fibula surpassed the strength of bone. No foot
bones in either position surpassed UCS or UTS of bone. Pressure isosurface contour
plots (Figure 4.48) confirmed the maximum stress locations in the tibia and fibula in both
positions.

Figure 4.44

S22, S33, and S23 (MPa) plots in the lower tibia comparing Position 1 and
2.
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Figure 4.45

S22, S33, and S23 (MPa) plots in the upper tibia comparing Position 1 and
2.

Figure 4.46

S33 and S23 (MPa) plots in the femur comparing Position 1 and 2.
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Figure 4.47

Von Mises (MPa) contour plots in Position 1 and 2 at 250g loading when
bone stress exceeds UCS and UTS.

Figure 4.48

Isosurface contour plots of pressure (MPa) in Position 1 and 2 at 250g
loading when bone stress exceeds UCS and UTS.

4.3.4

Bone Damage Incorporation
Next, the damage failure criterion for bone was incorporated into the simulations.

The plot of the acceleration results obtained in the lower tibia can be seen in Figure 4.49.
The rate of initial acceleration increase had an almost exact trend as the simulation
without damage, but peak acceleration was reached earlier. Looking at the deformed and
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final undeformed bones in the damage simulation (Figure 4.50), it was found that the
failure criterion was incorporated successfully. Some of the toe bones failed and were
deleted from the simulation, and a couple elements were deleted on the end of the talus,
which was in contact with the tibia. The simulations failed prior to completion due to the
ratio of deformation speed to wave speed exceeding 1.

Figure 4.49

Lower tibia acceleration from FE simulations with and without damage
compared to experimental data in 250g case.
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Figure 4.50

4.4
4.4.1

Bone failure which occurred in FE simulation of 250g case.

Discussion
Experimental Drop Tower Testing
The experimental drop tower tests found injuries only in the femurs of three out of

four of the 350g test specimens. No injuries were noted in any of the bones in the 250g
cases or in the tibias, fibulas, and foot bones of the 350g cases. In previous studies on the
lower extremity subjected to underbelly blast loading, the tibia, fibula, and foot bones
were the only injuries which occurred (Commandeur et al. 2012, Bailey et al. 2013, Perry
et al. 2014). This finding suggested that the experimental drop tower tests performed in
this study might have boundary conditions or test specimens not in agreement with what
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is seen on the battlefield. A summary of the uncertainties in the experiment are listed
below:


Size and anatomy of human cadaver specimen (weight, height, length of
leg, muscle mass, etc.)



Structure properties of human cadaver specimen (Age of cadaver, length
of time and how the specimen was stored, pre-history of cadaver, porosity
of bone, etc.)



Boundary conditions (Amount of fixation at the hip and foot, footplate
rotation, etc.)



Instrumentation accuracy (Error in acceleration recordings)



Time at which the femur fractured

The exact boundary conditions for how the foot and hip are attached to the sled
and footplate cannot be fully understood. They were both taped to the surfaces with cloth
tape. At high impacts cloth tape would allow for some motion at both locations, and this
is confirmed in the experimental videos. If the femur was not allowed to rotate normally
this could cause a fracture due to how it was fixed to the seat. The footplate also showed
rotation in the later portions of the test, which could be a reason as to why no injuries
were seen in the foot or lower leg bones.
In regards to the test specimens, the acceleration data read on the plates, on the
bones, and between legs on the same specimens varied considerably. This could be due
to instrumentation error or variation in specimen size (weight) and age. The specimens
which failed at 350g loading were much older than the specimen which did not. It is well
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known that older bone tissue has a less stiff response and weaker mechanical strength
((Evans 1976)).
Although the results from the experimental drop-tower testing are limited, due to
the amount of specimens, the acceleration data serves as a good comparison for
validation. The initial rise and decline in acceleration is the area of focus for our
simulations. These trends were similar in most cases, and since this acceleration pulse
occurs in less than 10 ms with little displacement of the lower extremity we can assume
that the femur failure occurs later in the experiment when a greater displacement is
observed.
4.4.2

Finite Element Analysis and Validation
We have successfully generated a lower extremity FE model that can be used in

in-vehicle simulations. By accurately validating our model, we will be able to simulate
the damage incurred on the lower extremity from under-belly blasts. This information
will allow for the enhancement of military personal protective equipment, vehicle design,
and management of injuries. The FE method has many advantages for evaluating designs
and improving injury criteria, but the uncertainties should be kept in mind and are listed
below:


Boundary conditions (where the lower extremity is fixed, how much
fixation actually occurs in real life, etc.)



Material properties (Age effects, strain rate effects, anisotropy, elastic
assumption, etc.)



Footplate placement
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Loading conditions (data read on the footplate in the experiment could be
invalid)



Bulk viscosity damping effects

Numerous simulations were executed varying boundary conditions and loading
setup. The findings from varying loading and boundary conditions confirm the high
dependence of the results on these conditions. It is extremely important to note
everything that occurs during the experiment in order to setup an accurate simulation. It
was found that Setup A, acceleration loading only, and Setup E, acceleration loading with
fixed boundary conditions at the hip, surface of foot, and foot bones, obtained a bounds
of the results accounting for the unknown value of fixation at the foot and hip locations in
the experiments. The average of the two simulations revealed a good match with the
experimental results in the rise of acceleration, peak acceleration, and decline of
acceleration in the lower tibia, upper tibia, and distal femur of both the 250g and 350g
loading cases.
The stresses were evaluated in all of the bones of the lower extremity. It is
important to note the difference in bone modulus and ultimate strength based on
specimen age, strain rate, and stress state (Table 4.3). The tibia and foot bones showed
stresses which exceed the UTS and UCS of bone. These findings match well with
literature, but were not observed in the experiments. This could be due to the
experimental footplate rotating some and not staying horizontal throughout the entire test.
The femur revealed stresses in the femur of the 350g case which exceed the UTS of older
specimens but not younger, revealing that the age of the specimen could correlate to the
bone fracture findings in the drop tower experimental studies, but not on field. The
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average age of active duty military personnel serving on the field in Iraq or Afghanistan
is 27 (Vaughn 2009), while the experimental specimens with femur fractures were much
older. The location of the peak stresses were near the ends of the shaft rather than midshaft, but this can easily be due to the location of hip fixation. If the femur had been
confined at a different location along its axis, the maximum stress location would likely
shift to the mid-shaft region of the bone.
4.4.3

Alteration in Foot Position
Since the loading in anti-vehicular blasts is transmitted through the floor, it is

important to consider the position of the occupant. There are two common foot positions
which come in contact with the floor. The foot is commonly in full contact with the floor
(90 degree angle between thigh and lower leg) or the heel only is in contact with the floor
(135 degree angle between thigh and lower leg).
The results showed similar loading in the lower tibia, but different outcomes in
the upper tibia and distal femur. Position 1 revealed a much higher acceleration and
principal stress states in the upper tibia and femur. This higher loading has been seen in a
previous study as well (Nilakantan et al. 2009). In Position 2, the heel contact, the ankle
allows more rotation causing flexion, or frequency, in the results. There is only a small
amount of rotation at the ankle in Position 1, allowing higher acceleration loading to be
transmitted up the lower extremity. This is due to Position 1 having primarily axial
loading, while Position 2 has shear loading as well.
Both positions revealed maximum stresses in the shaft of the tibias and fibulas.
Since these simulations were not fixed at the hip or foot locations, lower stresses were
seen than in our previous section. Position 1, however, still showed stresses which
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exceeded the ultimate strength of bone. The boundary conditions of the occupant greatly
affect these results. It can be said that Position 1 under the same boundary conditions as
Position 2 shows an increase risk in bone fractures throughout the leg, while Position 2
still has a high risk of fracture in the lower tibia, lower fibula, and foot.
4.4.4

Influence of Bone Material Properties Based on Specimen Age
Since the experimental results found fractures in the femur in three of the 350g

tests, simulations were carried out to address the changes in the bone material properties
due to strain rate and age of specimen. Since the Young’s modulus is rate dependent and
age dependent, a literature review was done to find out the values. The values found
ranged from source to source. In order to gain an understanding of how much the
changes in bone material properties affected the results, some extreme values for
Young’s modulus were evaluated.
Three simulations were executed varying the Young’s modulus value from 15
GPa to 150 GPa. With an increase in modulus it was observed that the initial rise in
acceleration was increased some, but not significantly. This was also observed for the
peak acceleration read in the bone. Since these results did not alter the acceleration data
read in the bones a large amount, it can be assumed that the stiffness of the bone was not
the cause of the femur failure.
4.4.5

Bone Damage Incorporation
Bone damage initiation and evolution were incorporated into the 250g loading

case. Bone failure was found in the foot bones, specifically the toes and the talus which
came in contact with the tibia. The simulations could not run fully due to the ratio of
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deformation speed to wave speed exceeding 1. This could be due to element quality or
interaction definitions at the deletion site. Further simulations need to be executed in
order to fully understand the error found.
It is important to note that failure can be incorporated into the model using
material models available in Abaqus. The current data used for the bone is preliminary
only. A more detailed model needs to be incorporated accounting for all stress states and
more accurate strain rates of the bone in high rate situations. A UMAT could also be
incorporated to account for bone damage.
4.5

Conclusions
Although the results from the experimental drop-tower testing are limited, due to

the amount of specimens, the initial rise and decrease in acceleration data serves as a
good comparison for validation. Our lower extremity model was successfully converted
into a seated position and the acceleration results read in the lower tibia, upper tibia, and
femur were in good agreement with the experimental data.
The experimental drop tower testing found that fracturing was only observed in
the femur of 350g cases, and no other bones in any other cases. From experimental
observations, it was concluded that the femur fractures were most likely due to the
experimental fixation and age of the specimen. The FE results found the stress in the
femur of the 350g case to exceed the UTS of older bone specimens, but not the UTS of
younger bone specimens. Stresses did exceed the ultimate tensile and compressive
strength of bone in the tibia and foot which literature confirms has higher injury
prevalence.
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It was also found that the position of the personnel in the vehicle has a large effect
on the acceleration and stress patterns in the lower extremity bones. The driver often has
his or her lower extremity extended so that only the heel of the foot is in direct contact
with the floor when the under belly blast occurs. Our results found that this configuration
sees high principal stresses, shear stresses, and accelerations in the foot and lower tibia;
however, due to more rotation occurring at the impact zone, injury is less likely to occur
further up the lower extremity.
The strength and failure of bone was also considered in the simulations. We were
able to incorporate failure initiation, but further studies need to be completed in order to
understand the interaction between different materials at the site of deletion. It was also
found that Young’s modulus did not greatly affect the results at the values recorded in
literature.
Overall, our simulations showed good correlation with the experimental studies.
They also provided insight into injury patterns seen in the lower extremity due to AV
mines. With more simulations varying the amount of loading and correlation with
explosive amounts, the prediction of specific stresses associated with common injuries in
vehicles can be obtained while at the same time shortening the cycle of development for
protection in these vehicles from blasts.
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CHAPTER V
EVALUATION OF MILITARY FOOTWEAR BLAST MITIGATING EFFECTS

5.1

Introduction
Anti-personnel (AP) landmines have become extremely prevalent in battle due to

their relative low cost, maintenance, and simplicity to deploy (Cronin et al. 2011). It was
estimated that over 100 million AP landmines are currently in unmarked fields worldwide
(Trimble et al. 2001). These land mines are often activated when a military personnel
steps on the mine (Chaloner et al. 2002, Harjai et al. 2004, Harjai et al. 2005). This threat
has led to the importance of evaluation and improvement of personal protective
equipment (PPE) in many countries.
Standard military boots provide minimal protection under blast loading and fail
easily. Several new designs have been made to specifically counteract AP mines. These
boots contain wedge designs, honeycomb energy absorbing structures, and structures
increasing standoff distance from the ground (Islam et al. 2000, McArthur et al. 2003,
Wolff et al. 2005). A variety of approaches have been used to test PPE, but each
methodology has issues addressing the following goals: consistency and repeatability,
cost, transferability, ability to rank protection based on injury outcome, and correlation to
level of trauma (Bergeron et al. 2002, Cronin 2003, Cronin et al. 2003, McArthur et al.
2003, Wolff et al. 2005, Cronin et al. 2011, Perry et al. 2014).
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Finite element analysis has become an increasing research area in PPE
development due to its ability to provide a reproducible testing means with low cost. For
numerical procedures to help with the advancement of PPE, more complex lower
extremity models and material models need to be developed. This chapter focuses on
integrating our lower extremity mesh from previous work into a common military boot
and evaluating the boot’s ability to protect the lower extremity and dissipate the blast
wave.
5.2
5.2.1

Methods
Boot Mesh Development
A commonly worn military boot (Bensel 2013) was obtained from the Reserve

Officers’ Training Corps (ROTC) at Mississippi State University (Figure 5.1). A surface
scan of the boot was taken and imported into ScanCAD, CAD software which can
convert surface data into a mask which can be used in ScanIP. Once converted to a
mask, the boot was then manually segmented in ScanIP into the following different
materials: leather covering, outer rubber sole, foam mid-sole, and insole. The laces were
excluded from the model since they have no purpose in mitigating the blast wave (Keong
2011).
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Figure 5.1

5.2.2

Boot obtained from the ROTC.

Boot and Lower Extremity Incorporation
After segmentation of the boot was completed, the boot was manually

manipulated in ScanIP in order to incorporate it into our lower extremity model. The
previous geometry of the lower extremity was developed from axial computed
tomography scans and cryosections contained from the National Library of Medicine’s
Visible Human Male. The foot of the lower extremity was at an angle, so it had to be
rotated and aligned in order for it to be standing flat. The boot did not fit the foot, so it
had to be scaled prior to importing it into the lower extremity file. Once it was scaled
successfully, the foot and boot were aligned by translating the boot along the x, y, and z
axis. Once appropriately aligned, the boot and lower extremity were meshed.
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5.2.3

Finite Element Analysis
Using Abaqus/Explicit, blast simulations were executed using the incident wave

procedure. Elastic material properties from literature were used for the skin, bone, and
muscle (Section 3.2.3). The boot mesh was simplified to contain only the outer sole,
mid-sole, and insole. Rubber, polyurethane foam, and ethylene-vinyl acetate material
properties were obtained from literature and assigned to the outer sole, mid-sole, and
insole, respectively. The leather was omitted since it has little effect on the blast
mitigation, and the metallic shank was also omitted due to studies which found that the
steel plate could cause more injuries (Keong 2011).
Rubber was modeled using the Marlow form of hyperelasticity. The uniaxial data
used to describe the material can be seen in Figure 5.2 (Muschek et al. 1997). The
density was 1250 kg/m³ (MatWeb). The Marlow strain energy formula is (Abaqus
Documentation):
𝑈 = 𝑈𝑑𝑒𝑣 (𝐼1̅ ) + 𝑈𝑣𝑜𝑙 (𝐽𝑒𝑙 )

(5.1)

Where U is the strain energy per unit reference volume, with 𝑈𝑑𝑒𝑣 as its deviatoric part
and 𝑈𝑣𝑜𝑙 as its volumetric part; 𝐼1̅ is the deviatoric strain invariant defined as:
𝐼1̅ = 𝜆1̅2 + 𝜆̅22 + 𝜆̅23

(5.2)

Where the deviatoric stretches 𝜆̅𝑖 = 𝐽−1/3 𝜆𝑖 ; 𝐽𝑒𝑙 is the elastic volume ratio; and 𝜆𝑖 are the
principal stretches. The deviatoric part is defined by the uniaxial test data, and the
volumetric part is defined by the Poisson’s ratio. EVA was also modeled using the
Marlow form, and its stress strain curve can be seen in Figure 5.3 (Li et al. 2009). The
density of EVA is 940 kg/m³ (MatWeb 2011). Polyurethane foam was modeled using the
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hyperfoam material model. The uniaxial data used to describe the material can be seen in
Figure 5.4 (Campbell et al. 1982). The density of polyurethane is 1300 kg/m³, and the
Poisson’s ratio is 0.3 (MatWeb 2011). Its strain energy formula is as follows:
𝑈 = ∑𝑁
𝑖=1

2𝜇𝑖
𝛼𝑖2

𝛼
𝛼
𝛼
[𝜆̂1 𝑖 + 𝜆̂ 2 𝑖 + 𝜆̂ 2 𝑖 − 3 +

1
𝛽𝑖

((𝐽𝑒𝑙 )−𝛼𝑖 𝛽𝑖 − 1)]

Where N is a material parameter; 𝜇𝑖 , 𝛼𝑖 , and 𝛽𝑖 are temperature-dependent material
parameters; 𝜆𝑖 are the principal stretches; and 𝐽𝑒𝑙 is the elastic term in the energy
function. 𝛽𝑖 is related to the Poisson’s ratio.

Figure 5.2

Stress-strain curve for rubber in uniaxial tension.

Figure 5.3

Stress-strain curve for EVA in uniaxial tension.
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(5.3)

Figure 5.4

Stress-strain curve for polyurethane foam in uniaxial tension.

Damage initiation and evolution were incorporated for the rubber and EVA
materials. The hyperfoam model is not supported by Abaqus for these failure criteria.
The parameters are summarized in Table 5.1, and the parameters used were discussed in
detail in Section 4.2.8. Simulations revealed no failure with these parameters. Due to
this finding, elastic properties were substituted for the rubber and EVA material model in
the simulations which incorporated damage. These values are summarized in Table 5.2.
Table 5.1

Summary of failure material model data for rubber and EVA.

Material

Failure Model
Plastic
Yield
Plastic
Stress
Strain
(MPa)
14
0
15
0.01875
16
0.1
5.2
0
5.6
0.1
6
0.6
6.2
0.8

Rubber
EVA

Ductile Damage
Fracture
Stress
Strain Rate Displacement
Strain
Triaxiality
at Failure (mm)
0.02625

0.333

0

0.1

0.5

0.333

0.01

0.1
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Table 5.2
Material
Rubber
EVA

Summary of elastic material model data for rubber and EVA.
Density (kg/m³) Young’s Modulus (MPa) Poisson’s Ratio
940
8000
0.495
940
40
0.4999

A heel detonation simulation was performed and compared to simulations without
boot incorporation. The basic setup can be seen in Figure 5.5. Several blast pressure
profiles were simulated to evaluate the amount of pressure dissipated by the addition of a
military boot. Three of the blasts will be reported in this chapter. A low peak and long
duration pressure wave (Figure 5.6) was applied, a mid peak and short duration pressure
wave (Figure 5.7), and a high peak short duration pressure wave was applied (Figure 5.7).
The low and mid peak simulations will focus on the dissipation associated with adding a
boot, while the high peak simulation will focus on the damage incorporation into the
material properties of the boot.
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Figure 5.5

Basic setup for blast simulations without and with boot.

Figure 5.6

Low intensity and long duration pressure wave.
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Figure 5.7

High intensity and short duration pressure wave and mid intensity and short
duration pressure wave

(Fichera et al. 2013).
5.3
5.3.1

Results
Geometry and Mesh
A 3D military boot model was successfully developed in ScanIP and incorporated

into the lower extremity model (Figure 5.8). For preliminary studies, the lower extremity
was meshed from the knee down and the leather portion of the boot was ignored. The
mesh contained approximately 4 million elements, which included the air, boot, and
lower extremity.
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Figure 5.8

5.3.2

(A) Boot masks and (B) boot masks incorporated into lower extremity in
ScanIP.

Boot Pressure Wave Propagation and Dissipation
Pressure was evaluated in the same manner as our previous studies (in each

material and along the line of blast wave loading) and compared to results of the lower
extremity without a boot. The boot was found to absorb and dissipate the majority of the
pressure wave prior to entering the foot in the low intensity blast case. Pressure in the
biological materials is approximately 100 times lower in the simulation with the boot
compared to without the boot in the low intensity blast case. This can be seen at points in
the skin, muscle, and bones of the foot (Figure 5.9). The boot simulations also show a
delay in the arrival of the pressure in the foot and a decrease in fluctuations or frequency
of the pressure wave. In addition to these factors, the boot is seen to slow the wave down
in the mid intensity, short duration results (Figure 5.10) and pressure is dampened
approximately 10 times in the simulation with the boot compared to without the boot.
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Figure 5.9

Pressure propagation in the foot in the simulation without and with the boot
at low intensity, long duration blast conditions.

Note: (A) and (B) skin point on the heel of the foot at initial impact point. (C) and (D)
muscle point in the foot muscles along line of blast propagation. (E) and (F) bone point
in the foot along line of blast propagation.
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Figure 5.10

Pressure propagation in the foot in the simulation without and with the boot
at mid intensity, short duration blast conditions.

Note: (A) and (B) skin point on the heel of the foot at initial impact point. (C) and (D)
muscle point in the foot muscles along line of blast propagation. (E) and (F) bone point
in the foot along line of blast propagation.
Contour plots from the low intensity blast of the pressure in the skin and boot can
be seen in Figure 5.11 as a side view and Figure 5.12 as a bottom view. Here it can be
seen that when the pressure wave enters the boot, the rubber outsole or tread has the
ability to redistribute the wave prior to it entering the foot. In comparison, in the
simulation without the boot, the wave propagates directly through the lower extremity
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biological materials, upwards and outward at the same time. The mid intensity, short
duration blast results further confirm this redistribution (Figure 5.13). It can be observed
in these plots that the pressure is evenly distributed on to the foot in the boot simulations
rather than dominating in the heel.

Figure 5.11

Pressure propagation (MPa) results from side view of low intensity, long
duration simulation without and with boot.
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Figure 5.12

Pressure propagation (MPa) results from bottom view low intensity, long
duration simulation without and with boot.

Figure 5.13

Pressure propagation (MPa) results from sagital cut mid intensity, long
duration simulation without and with boot.
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5.3.3

Displacement in the Boot and Lower Extremity
Displacement magnitude contours were also plotted in order to better understand

how the pressure wave propagates through the boot. At low pressure blast waves (Figure
5.14), the displacement is dominated in the boot while in the simulation without the boot
displacement can be seen in all of the biological materials. When subjected to higher
blast loading (Figure 5.15), the boot is seen to delay and distribute the displacement prior
to it entering the lower extremity. The simulation without the boot observes
displacement driving into the tibia.

Figure 5.14

Displacement magnitude (mm) in all materials without the boot (A) and
with the boot (B) after low intensity, long duration blast loading.
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Figure 5.15

5.3.4

Displacement magnitude (mm) in all materials without the boot (A) and
with the boot (B) after mid intensity, short duration blast loading.

Injury Evaluation in Bones and Muscles with or without Boot Protection
Next the pressure in the bones and muscles were evaluated from the mid intensity,

short duration results in order to find locations where maximum stresses occurred and
determine whether any ultimate strength values were surpassed. The simulations with
and without the boot found maximum stresses to occur in the shaft of the tibia, shaft of
the fibula, and foot bones (Figure 5.16). The pressures were much lower than the UTS
and the UCS of bone. The boot results showed pressure entering the toes and heel at the
same time, while the results without the boots showed pressure dominating in the heel
first and then dispersing up the leg and to the toes. The muscle results found the
maximum stresses to occur at the interfaces with the bones (Figure 5.17). The pressure
values were lower than that of failure. In the muscle and bone, the simulations with the
boot revealed much lower pressure values than the simulations without the boot.
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Figure 5.16

Pressure (MPa) in the bones without and with the boot.

Note: The contours have different scales on the legend due to the large difference in
results.

Figure 5.17

Pressure (MPa) in the bones without and with the boot.

Note: The contours have different scales on the legend due to the large difference in
results. Muscle is not torn (displays foot and lower leg muscles).
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5.3.5

Boot Damage Incorporation
Since the low and mid intensity blast resulted in no damage to the boot materials,

a high intensity short duration blast wave was simulated. The undeformed and deformed
configuration of the boot tread can be seen in Figure 5.18. The tread failed and is
accounted for by element deletion. The elements deleted near the source point on the
heel of the tread.

Figure 5.18

Material damage in the high blast pressure simulation.

Notes: (A) Undeformed and (B) deformed contours at 0.18 ms. Areas circled show were
elements deleted.
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The simulations failed early in the runs with the high intensity blast wave causing
the results to be limited. The simulation without the boot failed at 0.05 ms due to the
ratio of deformation speed to wave speed exceeding 1 in at least one element. The
simulation with the boot failed at 0.18 ms due to excessive distortion of an element.
Material failure parameters were not included for the skin; however, they were for the
boot outersole and midsole. This probably is the reason why the boot simulations ran
longer than the no boot simulations. The errors could be due to a number of factors in the
simulation and the status file lists the following checklist:
1. Check contact definitions for problems such as excessive initial
overclosure or unrealistic tied definition between contact pairs. A vector
plot of velocities or accelerations will usually help to identify contact
problems.
2.

Check stiffness (elastic modulus) and mass (density) definitions for
consistent units and verify that the combination is reasonable.

3. Check for poor mesh definition.
4. Check the boundary conditions for an excessive loading rate. The
*DIAGNOSTICS, DEFORMATION SPEED CHECK=DETAIL option
may be used to obtain detailed diagnostics information.
5.

Check the current status of the structure to see if it has totally failed.

6. A dashpot or a very stiff spring may cause the analysis to go unstable.
The *DYNAMIC, DIRECT option may be used to control the time
increment directly.
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5.4

Discussion
A commonly worn military boot was successfully meshed and incorporated into

the standing lower extremity model. The boot was found to absorb, dissipate, and delay
the majority of the pressure wave prior to entering the lower extremity. Although the
majority of our results were at low and mid intensity pressure waves, it allows for a
mechanistic understanding of the propagation through the boot into the lower extremity.
In the low and mid intensity simulations, no ultimate strengths were surpassed in
the boot or lower extremity biological materials. It was seen that the boot could reduce
the pressure approximately 100-10 times in the skin, muscle and bone tissue depending
on the blast intensity and duration. It has been noted in literature that at low blast
pressures, boots have been seen to absorb the majority of the pressure (Islam et al. 2000),
which is what occurred in our simulations. Rubber material in boots has been seen to
mitigate the peak stress by 70% (Ungerer 2008). The boot was found to redistribute the
pressure wave rather than it propagating directly into the lower extremity biological
materials. Distributing the pressure evenly into the bones, rather than dominating in the
heel and up the tibia, could reduce the number of fractures due to blast loading.
The high intensity simulation did not complete in both the simulation with and
without boot. This is most likely due to the size and quality of the elements which
deformed at extremely high rates. Further simulations will need to be executed in order
to find the exact reason for this. Incorporating failure criteria for the biological materials,
might allow the simulation without a boot to complete. This would allow for the deletion
of extremely deformed elements due to the high intensity blast wave. Viscosity damping
also needs to be considered in fixing this error.
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Although the results from the high intensity blast wave were limited, the results
did confirm the incorporation of damage criteria for the outer sole of the boot (rubber).
Material failure and element deletion were observed early in the simulation at the area
near the source detonation. This suggests that higher blast waves need to be simulated in
order to understand how much pressure the PPE can handle; however, the meshes need to
be optimized in order to complete the simulations and reduce computational cost.
It is important to have data from experiments or on field data to compare to the
experimental results. The blast loading data on the lower extremity and PPE in literature
tend to vary from source to source. Instrumentation which measures the values recorded
tends to show great variability (Chaloner et al. 2002). Many studies also leave out
pertinent boundary condition information in their methods section which is required to
accurately setup a simulation. This made it difficult to find a pressure wave which was
known to cause a specific amount of damage to a military boot and injury in the lower
extremity. This is why three extreme cases (very low, mid, and high) were simulated and
analyzed.
5.5

Conclusions
This is the first of many PPE studies that will be investigated using our lower

extremity model. In this study we were able to incorporate a commonly worn military
boot into our realistic lower extremity model. Several pressure profiles were subjected to
the lower extremity with and without boot protection. The results provided evidence of
the mechanistic understanding of how a boot can redistribute, dampen, and delay the
blast pressure wave propagation in the lower extremity.
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More studies need to be investigated with the incorporation of blast data which is
known to cause injuries in the lower extremity. Being able to evaluate how much energy
is dissipated by the boots can help the military to be able to investigate the level of
protection different boot designs provide. In the future more realistic material models
will be incorporated into the simulations which will provide a better understanding and
evaluation of injury threshold criteria in the lower extremity when exposed to blast wave
loading.
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CHAPTER VI
EARLY STAGE ASSESSMENT OF THE EFFECT OF HYPER-VISCOELASTIC
MATERIAL MODEL ON BLAST SIMULATION

6.1

Introduction
When it comes to biological material properties, there are many unknowns and

variables that come into play. Within the biomedical and mechanical fields, it seems that
there is a discrepancy amongst the community when it comes to dealing with
viscoelasticity at high rate loading, such as a blast. Some say that viscoelasticity affects
the results at high rates (Ozkaya et al. 2012, Gabler et al. 2014), while others say the
events are happening at such high rates that viscoelastic effects do not occur (Moore et al.
2009) .
To the author’s knowledge, there is limited viscoelastic data at high strain rates
available in literature for skin, muscle, and bone tissue. The data that is available is
obtained from testing which occurs at low strain rates (Bosboom et al. 2001, Tham et al.
2006, Hajjarian et al. 2012). For the data to be relevant for blast loading conditions, the
strain rates need to be much higher. Strain rates up to 10,000/s can be reached during
blast loading (Ramasamy et al. 2011).
In this chapter, hyper-viscoelastic material properties from literature are
incorporated into the open air blast scenario. The major reason for the incorporation is to
address the comments of reviewers, as this seems to be a major issue with some. Our
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findings suggest that more mechanical testing data is needed to fully understand the
effects of viscoelasticity at high rates. These tests are currently being performed by other
students.
6.2

Methods
To compare the effects of material properties on the blast simulations, viscoelastic

and hyperelastic properties were incorporated for the skin and muscle. The bone was
kept as an elastic material. The incident blast wave loading procedure was used as
mentioned in Chapter III. Case 2 (landmine) was simulated using the high pressure
profile from Section 3.2.3.
The hyperelastic response of skin was modeled using the Polynomial strainenergy function. The parameters were obtained from a previous study (Tham et al. 2006)
and were 𝐶10 =29.6 kPa and 𝐶11 =493kPa. The polynomial strain-energy potential
(Abaqus Documentation) is given below:
1

𝑁
𝑁
𝑈 = ∑𝑖+𝑗=1
𝐶𝑖𝑗 (𝐼1 − 3)𝑖 (𝐼2 − 3)𝑗 + ∑𝑖=1
(𝐽𝑒𝑙 − 1)2𝑖
𝐷

(6.1)

Where U is the strain energy per unit of reference volume; N, 𝐶𝑖𝑗 , and 𝐷𝑖 are material
parameters; 𝐼1 and 𝐼2 are the first and second deviatoric strain invariants, respectively; 𝐽𝑒𝑙
is the elastic volume ratio. The hyperelastic response of muscle was modeled using the
Ogden strain-energy function. The parameters used were obtained from a previous study
(Bosboom et al. 2001) and were 𝜇1 =15.6 kPa and 𝛼1 =21.4. The Ogden strain energy
potential (Abaqus Documentation) is given below:
𝑈 = ∑𝑁
𝑖=1

2𝜇𝑖
𝛼𝑖2

−𝛼𝑖

(𝜆1

−𝛼𝑖

+ 𝜆2

−𝛼𝑖

+ 𝜆3
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− 3) + ∑𝑁
𝑖=1

1
𝐷𝑖

(𝐽𝑒𝑙 − 1)2𝑖

(6.2)

Where 𝜆𝑖 are the deviatoric principal stretches 𝜆𝑖 = 𝐽−1/3 𝜆𝑖 ; 𝜆𝑖 are the principal
stretches; N, 𝜇𝑖 , 𝛼𝑖 and 𝐷𝑖 are the material parameters.
The viscous behavior for the skin and muscle was modeled using stress-relaxation
function based on the Prony series. The Prony series expansion of the stress relaxation
function 𝑔𝑅 (𝑡) is given below (Abaqus Documentation):
t

𝑔𝑅 (𝑡) = 1 −

−P
∑N
i=1 g i (1

−e

− G
τ
i

)

(6.3)

G
Where N, g −P
i , τi , and i = 1, 2 , …, N, are material constants. The material parameters

were obtained from literature (Bosboom et al. 2001, Tham et al. 2006) and are
G
−P
g −P
i (i=1,2)=0.1480 and 0.2520 and τi (i = 1, 2) = 2.123 and 9.371 s for skin, and g i =

0.549 and τGi = 6.01 s for muscle.
6.3
6.3.1

Results
Pressure Wave Propagation
The pressure propagation was evaluated in the skin, bone, and muscle along the

line of pressure loading and compared between simulations with elastic and hyperviscoelastic material properties for the skin and muscle (Figure 6.1). The hyperviscoelastic results in skin showed similar initial pressure loading, but the fluctuations
were dampened over time. The results in bone showed a decrease in initial pressure
loading and peak reached. Pressure propagation was decreased in the muscle results.

141

Figure 6.1

6.3.2

Pressure propagation in skin, muscle, and bone comparing results from
elastic and hyper-viscoelastic (HVE) material simulations.

Analysis of Primary Blast Injuries
Next the pressure propagation was further investigated in the bones and muscles.

The pressure propagation along the tibia and fibula had similar trends in the elastic and
hyper-viscoelastic simulations; however, the hyper-viscoelastic results had reduced
pressure peaks (Figure 6.2). The oscillations between compression and tension still
dominated and dampened as the pressure propagated further from the blast source point.
The hyper-viscoelastic muscle contours of pressure revealed a higher initial peak
compression and longer tensile states in the foot muscles (Figure 6.3). While the
transverse muscle cut averaged pressure showed a delayed and higher compressive and
tensile peak pressures (Figure 6.4). The oscillations in the wave also decreased. The
overall trend from a high compressive state to a long tensile duration was maintained.
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Figure 6.2

Pressure plots in the tibia and fibula comparing results from elastic
materials and hyper-viscoelastic material simulations.

Figure 6.3

Muscle pressure (MPa) contours comparing results from elastic and hyperviscoelastic (HVE) material simulations.
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Figure 6.4

6.3.3

Average pressure from the transverse cut of the muscle in Figure 6.3
comparing results from elastic and hyper-viscoelastic (HVE) material
simulations.

Displacement
Displacement contours were plotted for all of the materials in the elastic and

hyper-viscoelastic simulations (Figure 6.5). In the hyper-viscoelastic plots, higher
displacement is seen in the foot later in the simulation. Larger displacement is also
observed around the tibia and not through the upper portion of the leg as seen in the
elastic results. This means the skin is deforming more in the hyper-viscoelastic
simulation.
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Figure 6.5

6.4

Isosurface contour plots of displacement (mm) magnitude comparing
results from elastic and hyper-viscoelastic (HVE) material simulations.

Discussion
The hyper-viscoelastic results showed that the skin deformed more with the

hyper-viscoelastic material than with the elastic material. With a further look into the
material properties used, it can be observed that the hyperelastic response of skin was less
stiff than the elastic Young’s modulus. This is most likely due to the differences in the
experimental setups that the values were obtained. Variations in loading rate can cause
huge differences in stiffness. The same was found when evaluating the muscle material
properties.
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Since the hyperelastic response was less stiff, this allowed the skin and muscle to
deform more and absorb more of the pressure wave. This is why the pressure was seen to
dampen in the muscles and bones. This could also cause a decrease in pressure
oscillations in the materials.
When considering the effects of the viscoelasticity on the results, it is important to
note that the values considered for the stress relaxation were on a longer time scale than
the blast wave. This means that the viscoelasticity from this source cannot alter the
results at this rate of loading. Viscoelastic data will need to be obtained at higher rates.
Skin, bone, and muscle have all been noted in literature to have material responses highly
dependent on strain rate. With this knowledge, it is extremely important to evaluate the
viscosity effects at high strain rates.
The author has recently found a couple articles supporting the importance of
incorporating viscoelasticity in blast simulations. Heel pad tissue was tested in
compression at strain rates up to 57/s (Gabler et al. 2014). The results were then
incorporated into material models in drop tower testing simulations where the simulations
results showed high dependence on this incorporation. Experimental testing has been
performed on skin and muscle tissue at rates up to 3200/s (Loocke et al. , Untaroiu et al.
2005). The results showed that there were viscoelastic effects at these high strain rates.
6.5

Conclusion
Due to the high dependence of biological material properties on strain rate, the

effect of hyper-viscoelasticity at high rates needs to be determined. Literature has limited
data assessing viscosity of biological tissues at high rates. More mechanical testing at
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high rates needs to be performed to clear up the discrepancy amongst researchers as to
whether viscoelasticity is relevant at blast loading conditions.
Although incorporating viscoelasticity into the lower extremity model might solve
some questions reviewers have about the lower extremity model, it is well known that
more advanced material models need to be incorporated. It seems that the incorporation
of material response at different strain rates and stress states needs to be at a higher
priority than viscoelastic effects in blast loading simulations. These considerations will
be discussed further in the Limitations and Future Work Chapter.
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CHAPTER VII
CONCLUSIONS

A highly detailed standing lower extremity FE model was developed for
analyzing the effects of blast loading. The lower extremity was subjected to an open air
blast (anti-personnel mine) at several locations and pressure profiles. It has recently been
seen that compartment syndrome can occur in personnel with no apparent injuries. Our
FE results found stresses to exceed the ultimate strength in muscle, but no other material
correlating with this theory. The muscle tissue observed a high compressive state, and
then propagated into a lower, long duration tensile state which can lead to rupture of the
tissue. Maximum pressures were also found in the foot bones and shaft of the tibia which
correlates with injuries found in literature. It was also found that pressure was highly
dominated in the bone rather than all tissues when the personnel detonate the explosive
by stepping on it rather being next to someone who detonates it.
Next, a source of validation was needed for our lower extremity model. Due to
the difficulty with validating open air blast occurrences, the focus was turned to antivehicular mine blasts or enclosed blast occurrences. Experimental drop tower testing was
performed on cadaver specimens and acceleration data was recorded in the bones and
autopsies were performed to assess injuries. The lower extremity model was altered and
remeshed into a seated position for simulating the drop tower tests. The FE acceleration
results were in good agreement with the experimental data; however, it was found that
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the injuries which occurred in the experiment and simulations were highly dependent on
the boundary conditions and age of the specimen.
Last, it is also important to consider the effects of PPE on the lower extremity and
its mitigating effects. A commonly worn military boot was successfully incorporated
into the standing lower extremity model. The lower extremity model was subjected to a
heel AP detonation with and without a boot. The boot was observed to dampen,
dissipate, and delay the pressure wave prior to entering the lower extremity. The boot
also provided a means of even stress distribution into the lower extremity rather than
directly through the heel. This reduces the amount of axial stress on the tibia and fibula.
With more AP blast wave data, simulations could be executed using our lower extremity
model to improve PPE in a cost effective and timely manner.
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CHAPTER VIII
LIMITATIONS AND FUTURE WORK

8.1

Biological Structures
Although the lower extremity meshes used in the dissertation studies were

sufficient, more and enhanced structures could be incorporated. Tendons and ligaments
are currently being incorporated. These structures are extremely important in the load
transfer in the lower extremity. Fat tissue also needs to be incorporated since it has been
seen to provide energy dissipation in some high impact cases.
The bone structures also need to be altered in order to incorporate the different
types of bone and account for the bone marrow. The thickness of bone can vary in
different locations, and the difference in spongy versus compact bone needs to be
considered. This could be incorporated using density meshing techniques in ScanIP.
8.2

Biological Material Properties
Since biological materials contain a variety of complex structures and

mechanisms, the material properties can depend on a number of issues such as
viscoelasticity, anisotropy, and strain rate. This makes the isotropic elastic material
assumption valid for only preliminary studies as our study. The material properties used
in this study were obtained at much lower strain rates than those occurring with blast
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waves (Ngo et al. 2007). High strain-rate tests are being conducted to develop
viscoelastic-viscoplastic constitutive models for future modeling purposes.
There have been some studies looking at strain rates in compression of bone up to
1500/s; however, the results vary from source to source (Ramasamy et al. 2011). Most
found that the modulus increases with strain rate, but they had varying results as to
whether the strength increases with high strain rates(McElhaney 1996, Ferreira et al.
2006). There is a general consensus that bone behaves as a brittle material about 20/s,
but the ultimate strength values range from source to source. Brittle materials are highly
dependent upon geometry, size, and initial points of defects or weakness. This and
specimen preparation variability could explain some differences.
Skin and muscle tissue have also been seen to depend on strain rate (McElhaney
1996, Bo et al. 2014). There are limited studies looking at these effects. Overall, it is
seen that stiffness increases with strain rate. Even though there is large variability of
biological tissue mechanical responses in literature, it is apparent that strain rate needs to
be taken into consideration. Ramasamy suggests providing data of at least 15 m/s tissue
testing velocities, and that this might correspond to strain rates of up to 10,000/s.
Since the studies focus on the lower extremity, the variation in skin properties of
the foot should be explored. The pad of the foot, due to walking, is a much stiffer
material than skin tissue in the body in general. There are some studies that have looked
into the properties and found that they had significant effects on their simulations(Gabler
et al. 2014).
Damage needs to be incorporated into all of the materials in order to fully run all
ranges of blast simulations which would occur in AP and AV mines. These blasts can be
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on the GPa order causing complete disruption of the tissues and materials (Fichera et al.
2013). Damage was incorporated for bone, but this was a simple model which still needs
to be improved upon by incorporating multiple stress states and strain rates. The same
method needs to be performed with the muscle and skin tissue.
8.3

Open Air Blast Loading
Due to limited FE studies focusing on lower extremity blast injuries, the pressure

profiles used in this study provide an overall view of how pressure propagates in the
lower extremity rather than quantitatively accounting for actual internal, mechanistic
damage. Additional simulations must be executed under more extreme blast loading
conditions to obtain results relevant to situations in which fractures would occur. Having
a variation of results will allow for a more accurate injury prediction rather than the
current procedure which is associated with pressure profile data obtained from literature
which falls into lower lethality and injury zones (Usmani et al. 2010).
It is extremely complicated to model explosions due to the numerous factors that
have to be taken into consideration. In this study pressure profiles are used to apply the
blast loading conditions. It is difficult to obtain comparable pressure profile data from
literature due to the fact that details are usually missing or the pressure profiles are read
from a significant distance from the source which causes a decrease in peak pressure
(Makris et al. 2000, Cronin 2003, Chafi et al. 2010, Fichera et al. 2013). Having pressure
profiles which correlated to antipersonnel mine explosive mass levels at the same
standoff distance is important to have in order to develop an injury threshold criteria
based on pressure levels seen on field.
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8.4

Drop Tower Testing Specimens and Loading Conditions
More drop tower testing could be performed in order to improve the accuracy of

the data. Only four tests were run for each loading case, and the majority of the cadavers
were elderly. More specimens could be tested in order to provide more consistent data.
In order to achieve this, a more controlled experimental setup might need to be
considered or have the computational modeler attend the experiments to more accurately
understand the loading conditions. The amount of motion at the fixation points needs to
be highly controlled. Also, the footplate needs to be kept level during the entire loading
of the lower extremity.
Accelerometers could be placed on more locations, especially other portions of
the femur. This could help provide an understanding of when the fracture occurred.
Maybe the motion of the hip and foot could be tracked as well to provide a better idea of
the amount of motion at the locations of fixation.
8.5

Boot Design and Mesh
In future studies, the boot design needs to be more accurately designed or

simplified. Lots of difficulties were associated with incorporating a boot onto a foot
model since the sizes did not match. All of the layers in the boot were also manually
segmented. Due to the arch of the foot, this was not simple. It was extremely difficult to
match the interface between the boot and bottom of foot. A scan of someone standing in
a boot would be beneficial and not too difficult. This would provide a nice interface
between the boot and foot, and also allow for better segmentation of the boot layers.
In addition to an improved boot geometry and mesh, the effects of different
material properties used in blast mitigation could be simulated and compared. This could
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help with the identification of a better mitigation material which is not commonly used in
military boots. The material properties could be tested at high rates to obtain more
consistent data for blast studies.
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APPENDIX A
SCANIP 3D RECONSTRUCTION AND MESHING PROCEDURE
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A.1

ScanIP
ScanIP is a 3D image visualization and processing software developed by

Simpleware. In this study, ScanIP is used to develop several lower extremity meshes to
be used in finite element analysis. The software provides an environment which can
incorporate multiple image formats (MRI, CT, cyrosections, etc.) into one file.

These

images can then be analyzed, visualized, segmented, and quantified using a variety of
tools available in the package. The process used to generate high quality meshes will be
discussed in detail below.
A.2

Overview of Environment
The ScanIP environment is very complex and detailed, but with some practice is

fairly simple to use. An overview of the main environment can be seen in Figure A.1.
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Figure A.1

A.3

ScanIP working environment overview.

Importing Images
The images which are imported are called Background data in ScanIP. The

images will be viewed as Greyscale data even if the images were originally in color.
Several background data sets can be used within one ScanIP file by duplicating one set of
files and applying different filters to each background or by importing several different
sets of images. Figure A.2 shows an example of background data of all three views in the
2D windows.
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Figure A.2

A.4

Background data in ScanIP.

Segmentation
Once the images are imported, the next step is to segment the masks which will be

included in the final model from the background data. Masks are the different parts of
the model and are one or more volumes (binary). For example in a model of the lower
extremity different masks could include the following: the femur, skin, tibia, gluteus
maximus, etc. There are many options as to how the masks can be created. The methods
which were used throughout this dissertation will be discussed (Figure A.3).
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Figure A.3

Overview of procedures used for segmentation of masks.

1. The Paint tool under segmentation is a traditional manual paint tool. This is
commonly used when automatic methods cannot be used. Often used to clean up
the segmentation or disconnect unwanted regions. The Paint tool can be used to
add or delete individual pixels by clicking within a 2D view. The shape of the
paint brush can be a disk or square, and the size can also be changed by moving
the Brush size slider. The Smooth edges option allows the amount of voxel
artifacts caused by manual painting to be reduced, results in a smoother surface
when the 3D representation is created.
2. Paint with threshold allows the use of thresholding while manually painting.
This provides a method of restricting what you paint or unpaint to a specific
voxels. The grayscale boundaries (Lower value and Upper value) can be set in
the Threshold settings. Values outside of these boundaries will not be affected
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when painting. To visualize how these limits will be applied you can activate the
Threshold preview. The same settings mentioned in the Paint tool will also
apply here.
3. The Threshold tool allows the user to select a window of grayscale values and is
useful where segmentation can be achieved based on grayscale intensities, for
example when segmenting bones. ScanIP uses a range of 0-255 pixel values, and
the Lower and Upper threshold values can be set between these values.
Interactive threshold allows the user to visualize the result of thresholding on
the active slice. Preview allows the user to choose any slice and visualize the
resulting segmentation.
4. Floodfill is a region growing algorithm which allows the user to fill based on
similarity and connectivity (measured by threshold value). The segmentation is
applied by clicking on a pixel in the Active view.
There are some techniques that need to be kept in mind when segmenting. When
using the segmentation tools the user can choose to perform the process (such as
painting) on more than one slice. This is done by selecting more than one slice number in
the Slice Browser using the shift key. The Perform on option in the Segmentation tab
will need to be selected as Selection. This process can be seen in Figure A.4.
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Figure A.4

Process for selecting more than one slice when performing segmentation.
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It is also important to realize that the order of the masks in the mask tree makes a
difference. If a mask of the whole volume exists, it needs to be lower on the Maks tree in
the Dataset Browser. For example, the bone mask needs to be above the skin (contour)
mask. Figure A.5 shows how the order affects the 2D view window.

Figure A.5

Importance of mask order in Dataset browser.

(A) Incorrect mask order (showing that bone cannot be seen). (B) Correct mask order.
A.5

Filters

A.6

Translating/Rotating
When using the National Library of Medicine’s Visible Human Male (National

Institute of Health, MD), only one position of the human body is available (standing or
laying). Sometimes other positions are need such as a seated position. This can be
achieved by using the original model in ScanIP and manually rotating and translating
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different parts until the position wanted is achieved. Rotating and translating can be done
by accessing the Align tool. To open the Align window (Figure A.6): Data → Align…

Figure A.6

Align window: Used to rotate or translate masks.

1. Select the Target, what is to be rotated or translated. Can select Active Mask or
Visible Mask (s).
2. Select Rotation Method.
a. No Rotation: This allows user to apply translation only.
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b. Specify Angles: This allows user to directly specify rotation angles in
degrees for the X, Y, and Z axis.
3. Specify Angles in degrees if rotating.
4. Select Translation Method.
a. No Translation: This allows the user to apply rotation only.
b. Type in Offset: This allows user to specify values of translation in X, Y,
and Z.
5. Type in the specific Offset values.
Another important tool to remember when performing rotations and translations is
the Shrink wrap tool. When applying multiple translations and rotations, extra pixel
data is added to the model (black empty space) which is not needed in the model. This
causes the file to become extremely large and the computational time will increase
immensely. In order to avoid this, use the Shrink wrap tool after applying any translation
or rotations. To open the Shrink wrap window (Figure A.7): Data → Shrink wrap…
Accept defaults in window and click OK.
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Figure A.7

A.7

Shrink wrap window.

Meshing
Once all masks have been created, it is now time to create a mesh which will be

used in Abaqus. This can be achieved by following the steps below and in Figure A.8.
1. Create a new model by double clicking Models in the Dataset browser.
2. Select the masks in the Dataset browser, right click, and select Add to
active model.
3. Change the Working dataset to Models. This will allow the user to work
with the model.
4. Double click on the model which was just created. This will open the
Model configuration window. Here the Export type can be changed.
Abaqus volume (Solid/shells) is the default and what is needed for the
simulations used in this study.
5. Go to Contacts tab. Create the contact pairs needed by selecting the
masks From and To and clicking Add contact pair. This is used to
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create the surfaces which will be used to define the contact definition
between different materials such as bone and muscle.
6. Click Close.
7. In the 3D view, make sure Models is selected and click Mesh.
8. When meshing is complete, click Export and save the file.

Figure A.8

Steps required to create a mesh.

If the mesh is too large, the data set will need to be down sampled. This involves
making the pixels of the image account for a larger area. Usually a pixel represents a 1
mm x 1 mm square of the data, but to make coarser meshes with fewer elements the pixel
may need to represent up to 5 mm x 5 mm. This can be achieved by going to Data →
Resample… and changing the pixel spacing (Figure A.2).
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APPENDIX B
ABAQUS BLAST FINITE ELEMENT ANALYSIS PROCEDURE
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B.1

Abaqus
Abaqus is a finite element method software developed by Dassualt Systemes. It is

used for solving and simulating engineering problems which can range from simple linear
analyses to complex nonlinear simulations. In this dissertation, Abaqus is used to
investigate the blast effects on the lower extremity. The process used to simulate open air
blast scenarios will be described in detail below.
B.2

Abaqus/CAE Modules (Environment)
Abaqus/CAE (the Complete Abaqus Environment) is an interactive environment

divided into multiple modules accounting for the aspects of the modeling process (ex:
defining the geometry, defining material propertiers, generating mesh, etc.) As the user
moves from module to module, the model will be built. Once it is completed, an input
file is generated, and it will be used to submit to the analysis portion of ABaqus.
Abaqus/Standard or Abaqus/Explicit reads the input file, performs the analysis, sends
information to ABaqus/CAE to monitor job progress, and generates an output database
(results). Last in the Visualization module, the results can be viewed.
Units are an important topic to remember when using Abaqus. Abaqus has no
defined set of units, but allows you to choose a system of units. All input data must be
kept consistent. The SI (mm) units were chosen in this study (Table B.1). It is important
to remember to convert all units to these when entering them in Abaqus.
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Table B.1

Abaqus units used in this dissertation.
Quantity
Length
Force
Mass
Time
Stress
Energy
Density

B.3

SI (mm)
mm
N
tonne (103 kg)
s
MPa (N/mm2)
mJ(10-3 J)
tonne/mm3

Starting Abaqus on Linux and Importing ScanIP File
After successfully developing a mesh surrounded in “air” with ScanIP, the input

file needs to be imported into Abaqus. If you are using Linux the following command is
used to open the application: abaqus cae. Once Abaqus is loaded, select Create Model
Database to open a new Abaqus file. To import the mesh created in ScanIp go to
File→Import→Model. Change the file filter to Abaqus Input File (*.inp,*.pes) and
select the file exported from ScanIP. The mesh will be imported as one part with
separate sets accounting for all of the different masks that were segmented in ScanIP.
Materials and sections for each mask will also be imported. If contact pairs were created
in ScanIP, these will appear as Interactions and Interaction Properties in the model tree.
The user needs to delete the interaction properties that were automatically created, as
these cause errors which will not allow the simulation to be executed.
B.4

Materials
The material properties will need to be edited since the imported material

properties serve as “place holders.” This can be achieved by right double clicking on the
material name or right clicking and selecting Edit. The Edit Material window will open
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and Material Behaviors will need to be selected and entered next. The material behaviors
selected in this window depend on what types of materials are being used. Elastic,
viscoelastic, and damage incorporation were used in the simulations in this dissertation
and the use of each will be discussed.
B.4.1

Elastic
For elastic material properties, the density, Young’s Modulus, and Poisson’s

Ratio need to be identified. In the Edit Material Window do the following:
1. Select General → Density. Enter in the mass density.
2. Select Mechanical → Elasticity → Elastic. Enter in the Young’s Modulus
and Poisson’s Ratio.
B.4.2

Hyper-viscoelastic
For viscoelastic material properties, there are many options that can be selected.

The one used in this dissertation will be described. In the Edit Material Window (Figure
B.1) do the following:
1. Select General → Density. Enter in the mass density.
2. Select Mechanical → Elasticity → Hyperelastic.
3. Select the strain energy potential → Ogden or Polynomial
4. Press the Test Data drop down button → Select Uniaxial Test Data →
Enter in the test data for the Nominal Stress and Strain.
5. To manually enter Poisson’s ratio click under “Data to define volumetric
response”.
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Figure B.1

B.4.3

Edit material window showing hyperelastic material steps.

Damage
There are many options on how to incorporate damage in to a material model in

Abaqus. The method used in this dissertation will be described. In the Edit Material
Window do the following:
1. Select General → Density. Enter in the mass density.
2. Insert elastic material properties for the material as mentioned in Section
B.4.1.
3. Enter plastic material properties. Select Mechanical → Plasticity →
Plastic. Enter data for Yield Stress and Plastic Strain.
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4. Select Mechanical → Damage for Ductile Metals → Ductile Damage.
Enter Fracture Strain, Stress Triaxiality, and Strain Rate data.
5. Press Suboptions drop down button → Select Damage Evolution. Enter
Displacement at Failure value.
B.5

Sections
If ScanIP was not used to create the model, the next step is to create a Section for

each of the parts in the model. Double click on Sections in the Model Tree and the
Create Section window will open (Figure B.2). Depending on what type of elements and
structure the section is being created for will determine what is chosen here. For most
structures do the following:
1. Name the section.
2. Leave defaults (Solid and Homogeneous) and click Continue…
3. Select the material and press OK.
4. Next click Assign in the main toolbar and Section.
5. Select the regions to be assigned to the section and click Done.
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Figure B.2

B.6

Steps showing how to create a section

Assembly
If ScanIP was not used to create the model, the assembly needs to be created

manually. Double click on Instances and the Create Instance window will pop up. Select
all parts needed in the model. Accept defaults and click OK. Parts can be repositioned
relative to each other if needed in this section.
B.7

Steps
Next a step needs to be created. Double click on Steps in the Model Tree and the

Create Step window will open (Figure B.3). To create a new step:
1.

Name the step.

2. Select Dynamic, Explicit as procedure type. Then click Continue… The
Edit Step window will open.
3. If the user would like, a description of the step can be included.
4. Insert the time period of the step in seconds. This value varies depending
on how long the blast wave occurs.
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Figure B.3

B.8

Windows involved in creating a step.

Interactions and Interaction Properties
Remember all automatic interactions imported with ScanIP file need to be deleted

or the simulation will fail. The automatic interaction properties can be deleted as well,
but if they are left it will not affect the simulation. This section will be used to apply the
blast loading condition. To create the interaction and interaction properties follow these
steps:
1. Double click Interactions in Model Tree. The Create Interaction window
will popup.
2. Name the Interaction.
3. Select the Step created in Section B7.
4. Select Incident wave as the Types for Selected Step and Click Continue…
5. Select the Source Point (reference point created on air).
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6. Select the incident wave standoff point (point on outside of structure blast
wave will be impacting). This was a skin point on the leg in this
dissertation.
7. Select regions for the surface. Click Surfaces… button. Select skin with
air surface created in ScanIP. The Edit Interaction window will popup.
8. Leave Pressure as the definition.
9. Click Create… button next to Wave Property. The Create Interaction
Property window will open. Select Incident Wave as Type. Click
Continue… The Edit Interaction Property window will open. Enter the
speed of sound in the fluid. Enter the fluid density. Select Spherical for
Defintion and Acoustic for Propagation model. Click OK.
10. Enter 1 in Reference Magnitude.
11. Click Create… button next to Pressure Amplitude. The Create Amplitude
window will open. Name the amplitude. Select Tabular as Type and
Click Continue… Enter in pressure data for pressure profile being used.
Click OK.
Note that Step 5 and 6 are very important points that need to be chosen precisely.
These points need to be selected in line with each other. When using a complex
geometry, it is often easier to create reference points for each. Follow these steps to
create a reference point:
1. Make sure the Module is set to Interaction.
2. Click Tools in the main drop down menu and click Reference Point…
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3. Click the Create Display Group to open the window. Select Sets under
Item and select the skin set. Click the Replace Boolean Button. This will
display only the skin elements.
4. Go to tools and select the View Cut Manager. This will allow the user to
cut through the skin to a certain point allowing for more specific point
selection. Select a point name it Standoff.
5. Repeat these steps for the air and create a Source Point at the same cut as
the standoff point. This will ensure the points are in line with each other.
B.9

Constraints
Constraints will be used to define the interaction between each material in the

simulations. The materials in this dissertation are defined as Ties. To create a tie follow
these steps:
1. Double click Constraints in Model Tree. Create Constraint window will
open.
2. Name the constraint.
3. Select Tie as the Type and click Continue…
4. Click Surface button for the master type. Click the Surfaces… button.
The Region Selection window will open. Select the surface which will be
the master surface. This will be the tougher material. Click Continue…
5. Click Surface button for the slave type. Click the Surfaces… button. The
Region Selection window will open. Select the surface which will be the
slave surface. This is the surface the will move based on the Master
Surface’s movement. Click Continue…
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6. The Edit constraint window will open. Accept defaults and click OK.
B.10 Analysis – Jobs
Before creating the job for a simulation using the Incident Wave Procedure, the
model attributes need to be adjusted (Figure B.4). To do this go to Model → Edit
Attributes → and select the current model. The Edit Model Attributes window will open.
Check the box next to Specify acoustic wave formulation. Select Scattered wave and
click OK.

Figure B.4

Steps to edit the model attributes for an incident wave procedure.
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Once everything is setup for the simulation, a Job needs to be created.
1. Double click Jobs under Analysis in the Model Tree. The Create Job
window will open.
2. Name the Job with a unique name (description and date).
3. Leave model as the Source and select the model that was just created.
Click Continue…
4. Enter a description if desired and click OK.
If using a ScanIP model this jobs are extremely large, so the simulations will have
to be submitted using numerous processors requiring use of the cluster at CAVS. The
next step is to create an input file. This is done by right clicking on the job that was just
created. Select write input. An input file will be written to the current work directory.
To determine or change the location of the work directory go to File → Set Work
Directory… The input file has the extension .inp and will be used when submitting to the
cluster.
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